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Preface
Copyright and Trademark Notice
Copyright 2014 Telestream, Inc. All rights reserved. No part of this publication may be 
reproduced, transmitted, transcribed, altered, or translated into any languages without 
written permission of Telestream, Inc. Information and specifications in this document are 
subject to change without notice and do not represent a commitment on the part of 
Telestream. 

Telestream, CaptionMaker, Episode, Flip4Mac, FlipFactory, Flip Player, Lightspeed, 
ScreenFlow, Vantage, Wirecast, GraphicsFactory, MetaFlip, MotionResolve, and Split-
and-Stitch are registered trademarks and Pipeline, MacCaption, e-Captioning, and Switch 
are trademarks of Telestream, Inc. All other trademarks are the property of their respective 
owners..

QuickTime, Mac OS X, Final Cut Pro, and Safari are trademarks of Apple, Inc. Bonjour, 
the Bonjour logo, and the Bonjour symbol are trademarks of Apple, Inc.

All other brand, product, and company names are property of their respective owners, and 
are used only for identification purposes.

MPEG-2 License Requirements
Telestream has obtained a license from MPEG LA, to produce MPEG-2 video, to meet the 
following requirement on behalf of its FlipFactory and Pipeline licensees: The use of this 
product in any manner that complies with the MPEG-2 standard is expressly prohibited 
without a license under applicable patents in the MPEG-2 patent portfolio, which license is 
available from MPEG LA, L.L.C., 250 Steele Street, Suite 300, Denver, Colorado 80206.
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Customer Support
Telestream offers technical support through our Web site and email. 

Email contacts: 

• Sales:  sales@telestream.net

• Support:  desktopsupport@telestream.net

Website Links: 

• How to Buy:  http://www.telestream.net/purchase/store.htm

• Support: 
 http://www.telestream.net/telestream-support/wire-cast/support.htm

We'd Like to Hear from You!
Telestream welcomes comments, feedback, and suggestions about your experience with 
Wirecast. You can reach us at support@telestream.net.

If you have suggestions about improving the tutorials or this guide, other Telestream 
documents, or our Web site, please email us at techwriter@telestream.net.

Limited Warranty and Disclaimers
Telestream, Inc. (the Company) warrants to the original registered end user that the 
product will perform as stated below for a period of one (1) year from the date of shipment 
from factory:

Hardware and Media. The Product hardware components, including equipment supplied 
but not manufactured by the Company but NOT including any third party equipment that 
has been substituted by the Distributor for such equipment (the “Hardware”), will be free 
from defects in materials and workmanship under normal operating conditions and use.

Software. If software is supplied as part of the product, the software will operate in 
substantial conformance with specifications set forth in its product user's guide. The 
Company does not warrant that the software will operate uninterrupted or error-free, will 
meet your requirements, or that software errors will be corrected.

Warranty Remedies
Your sole remedies under this limited warranty are as follows:

Hardware and Media. The Company will either repair or replace (at its option) any 
defective Hardware component or part, or Software Media, with new or like new Hardware 
components or Software Media. Components may not be necessarily the same, but will be 
of equivalent operation and quality. 

Software. If software is supplied as part of the product and it fails to substantially conform 
to its specifications as stated in the product user's guide, the Company shall, at its own 
expense, use its best efforts to correct (with due allowance made for the nature and 
complexity of the problem) such defect, error or nonconformity. 
Wirecast User Guide | 142779
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Software Updates
If software is supplied as part of the product, the Company will supply the registered 
purchaser/licensee with maintenance releases of the Company’s proprietary Software 
Version Release in manufacture at the time of license for a period of one year from the 
date of license or until such time as the Company issues a new Version Release of the 
Software, whichever first occurs. To clarify the difference between a Software Version 
Release and a maintenance release, a maintenance release generally corrects minor 
operational deficiencies (previously non-implemented features and software errors) 
contained in the Software, whereas a Software Version Release adds new features and 
functionality. The Company shall have no obligation to supply you with any new Software 
Version Release of Telestream software or third party software during the warranty period, 
other than maintenance releases.

Restrictions and Conditions of Limited Warranty
This Limited Warranty will be void and of no force and effect if (i) Product Hardware or 
Software Media, or any part thereof, is damaged due to abuse, misuse, alteration, neglect, 
or shipping, or as a result of service or modification by a party other than the Company, or 
(ii) Software is modified without the written consent of the Company.

Limitations of Warranties
THE EXPRESS WARRANTIES SET FORTH IN THIS AGREEMENT ARE IN LIEU OF 
ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT 
LIMITATION, ANY WARRANTIES OF MERCHANTABILITY OR FITNESS FOR A 
PARTICULAR PURPOSE. No oral or written information or advice given by the Company, 
its distributors, dealers or agents, shall increase the scope of this Limited Warranty or 
create any new warranties.

Geographical Limitation of Warranty. This limited warranty is valid only within the 
country in which the Product is purchased/licensed.

Limitations on Remedies. YOUR EXCLUSIVE REMEDIES, AND THE ENTIRE 
LIABILITY OF TELESTREAM, INC. WITH RESPECT TO THE PRODUCT, SHALL BE AS 
STATED IN THIS LIMITED WARRANTY. Your sole and exclusive remedy for any and all 
breaches of any Limited Warranty by the Company shall be the recovery of reasonable 
damages which, in the aggregate, shall not exceed the total amount of the combined 
license fee and purchase price paid by you for the Product. 

Damages. TELESTREAM, INC. SHALL NOT BE LIABLE TO YOU FOR ANY DAMAGES, 
INCLUDING ANY LOST PROFITS, LOST SAVINGS, OR OTHER INCIDENTAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF YOUR USE OR INABILITY TO USE 
THE PRODUCT, OR THE BREACH OF ANY EXPRESS OR IMPLIED WARRANTY, 
EVEN IF THE COMPANY HAS BEEN ADVISED OF THE POSSIBILITY OF THOSE 
DAMAGES, OR ANY REMEDY PROVIDED FAILS OF ITS ESSENTIAL PURPOSE.

Further information regarding this limited warranty may be obtained by writing:
Telestream, Inc.
848 Gold Flat Road
Nevada City, CA 95959

You can call Telestream, Inc. via telephone at (530) 470-1300.
Wirecast User Guide | 142779



Preface
Limited Warranty and Disclaimers

14
Wirecast User Guide | 142779



15
Introduction
Introduction
This guide is intended to help you understand how each feature of Wirecast operates 
and to provide you with information to help you make the best presentations possible.

Topics
 Editions and Options

 Wirecast Workflow

 Tutorials

 Two Ways to Use this Application

 Using AutoLive

 Main Window Layout

 Scripting APIs

Editions and Options
Wirecast is available in multiple editions. The editions of Wirecast, each with its own set 
of features, are presented in this guide. The term Wirecast is used, generally, to describe 
all major features. 

Editions
Wirecast is available in two editions:  Studio and Pro.

Wirecast Studio  allows an unlimited number of cameras and inputs, titling overlays, 
chroma keys, multiple layers, shot editing, and the ability to preview shots prior to 
broadcast. 
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Features that pertain specifically to Wirecast Studio are indicated by the Studio icon 
(shown below):

         

Wirecast Pro is the professional edition of Wirecast and includes all the features of 
Wirecast Studio. It adds an audio inspector, advanced audio controls, virtual sets, 
scoreboards, and many other professional features. Features that pertain specifically to 
Wirecast Pro are indicated by the Pro icon (shown below):

 

Options

         

Wirecast Studio provides support for multiple cameras and inputs, selected Blackmagic,  
Osprey by Variosystems, and Matrox Multi capture cards and LiveU video-over-cellular 
backpack. Users can broadcast their computer desktop (including computer audio) 
using Desktop Presenter. Other key features include chroma key support, 3D graphics, 
titles, transitions and up to 35 layers of live compositing. Additionally, you can use HDV 
when you purchase an HDV option license. Without the license you can still experiment 
with HDV input, but all HDV output is water-marked.

Wirecast Pro provides Virtual Sets (a library of professionally designed 3D sets), a 
powerful Audio Inspector with synch delay, Web stream support, integration with 
Teradek Cube. Wirecast Pro also provides live scoreboards and includes the HDV option 
license which adds support for HDV codec encoding.

Note: If you do not have a Wirecast Pro or Studio license, Wirecast still enables you to 
experiment with Pro or Studio features, but all Wirecast Pro and Studio output is water-
marked. Additionally, you can not save a document that has Pro or Studio features 
enabled.

Wirecast Workflow
Wirecast is a powerful cross-platform live video switching, production, and encoding 
software.  Because of its versatility in handling a variety of inputs and outputs, it 
typically fits in the middle of your broadcasting workflow.  Wirecast can take the place 
of more traditional T-bar hardware switchers, graphics and title generators, or simply 
act as the backend encoder for large switching systems.  

STUDIO

PRO

STUDIO

PRO
Wirecast User Guide | 142779
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Below is a diagram of the basic Wirecast workflow.  In general, you will capture your live 
input devices (such as live camera feeds, iOS cameras, computer desktop, web feeds 
and more), produce your show using the full range of Wirecast's production features 
(chroma key, graphics, titles, scoreboards, etc.), and then stream it live to web, LAN, or 
record locally.

Go button
Wirecast User Guide | 142779
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Wirecast works with cameras, capture cards, audio devices. It prepares media and then 
outputs it either by streaming to the Internet, CDNs, multicast/unicasts via LAN, locally 
via virtual output or second display, or Pro's Blackmagic Output feature. 

Tutorials
We suggest that you first work through the tutorials in the Tutorials section. They are 
quick, informative, and the easiest way to become familiar with Wirecast.

Wirecast provides a built-in tutorial environment that corresponds with the tutorials 
provided in Tutorials. The tutorials take about thirty minutes and provide a brief 
overview of how to set up a basic presentation and create your own broadcast.

Next, we suggest that you read Making Great Presentations. This topic shows you how 
you can easily make changes in your setup and improves the quality of your 
presentations.

Two Ways to Use this Application
There are two different ways you can use Wirecast:

• Presenter Is Operator The person conducting the presentation also operates 
Wirecast.

• Presenter Plus Operator The presenter concentrates on the content and someone 
else operates Wirecast. In this mode, the presenter never needs to know in detail 
how Wirecast works.

Go button
Wirecast User Guide | 142779
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Presenter Is Operator
In this mode of operation, the person conducting the presentation simultaneously 
operates Wirecast.

Here are some suggestions for using Wirecast when you are both the presenter and 
operator:

• Keep it simple Set up Wirecast to make it easy for you to be the operator and the 
presenter. Set up your logo and titles so that you need to make very few changes 
during your presentation. Use a minimum number of shots so it’s easy for you to 
see which shot to choose.

• Keep the AutoLive feature on This enables you to present your shots with just one 
click. Though this limits your ability to perform complex presentations, it is the best 
way when the presenter is also the operator. To turn AutoLive on or off, select it 
under the Switch menu.

• Pre-configure your shots Make sure that all the shots are created prior to your 
presentation. Do not try to create or modify shots while broadcasting them.

• Use hot-keys for switching shots If your shot has a number in its name, you can 
press the Option key plus that number’s key to immediately display the shot. For 
example, if you have a shot named “Me With Title 1”, press the Option key and the 1 
key to display this shot. Make sure you rename a shot and add a number to take 
advantage of using hot keys.   

Presenter Plus Operator

          

In this mode of operation, an engineer (or operator) is responsible for using Wirecast, 
and the presenter concentrates on the content of the presentation. 

Here are some suggestions for using Wirecast when you have both an operator and a 
presenter:

• Keep the AutoLive feature off This enables you to make several changes at one 
time before taking the changes live. However, to quickly make a shot live, press the 
Command+Ctrl keys and click the shot.

• Open the Preview window The operator should use Preview mode to examine 
everything before it becomes live.

• Use the Layer Windows to make more shots available Select New Layer Window 
from the Window menu to open additional layer windows so you can quickly flip 
between shots on several layers.

• Use the Inspector window to open and edit shots The Inspector window acts 
exactly like the edit window but always edits the last shot you changed. To open 
the Inspector Window, click on the Window menu and select Inspector.

STUDIO
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Using AutoLive
Some users of Wirecast may want to single-click a shot to make it become live. Other 
users may want to make several changes to the broadcast before making them live. You 
can use both methods in Wirecast.

The AutoLive feature is designed to offer a single-click operation for those users who 
want to simply click from shot to shot. The Edit window (or other windows) is not 
affected by the status of AutoLive.

When AutoLive is on, clicking a shot in the Main Window makes it become live. As a 
result, the Go button becomes inactive. Command+Ctrl+Click loads a shot into the 
preview but does not make it live.

When AutoLive is off, you click on a shot in the Main Window to display it in Preview, 
then the Go button is required to make the shot live. Command+Ctrl+Click takes a shot 
live immediately.

Sometimes you may want to temporarily turn on and off (toggle) the AutoLive state. 
Hold down the Command and control keys at the same time to temporarily turn on 
Autolive. This enables you to quickly switch AutoLive on for one action (i.e. a mouse-
click), then off again.

Main Window Layout
Wirecast enables you to select which functions are displayed in the Main window. 
These functions are added or removed from the main window using the Layout menu.

      

Go button
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There are three layout options: Preview, Master Audio, and Main Shot List. Each option 
represents a pane in the Main window and is turned on or off by selecting it. A check 
mark indicates that the option is turned on.

Preview Master Audio 

Main Shot List
Wirecast User Guide | 142779
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Preview

            

Preview displays what the broadcast will look like when you click the Go button. (The 
Go button is only active when AutoLive is off.) To display the Preview window, click 
select Layout >Preview.

STUDIO

Preview window

Go button

Live Broadcast Area
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Master Audio
The Master Audio panel enables you to control the output volume level, mute audio 
output, and mute the line-out feed for Preview and Live displays. To display Master 
Audio for Preview and Live displays, click Layout > Master Audio. Click again to hive the 
Master audio controls.

The Preview and Live Master Volume controls enables you to adjust the master audio 
volume for Preview and Live separately. Click and drag the slider control up or down to 
set the volume. The decibel scale next to the slider indicates the audio level. When you 
take a Preview shot  live, the Live audio controls are set to the levels set in Preview. 

The Master Mute button controls the mute of the Live master audio (what your viewers 
hear). Even when you mute the output, the encoder still generates audio but it is silent. 
If you don’t want to broadcast audio, modify the Encoder Presets to not process audio 
through the encoder.

The Preview and Live Line-Out Mute buttons control what you hear locally. When line-
out is muted, audio is not sent to your headphones or speakers, but your viewers still 
hear it. The two controls are mutually exclusive -- you cannot have both on at the same 
time, but you can mute both.

Live Master 
Volume 

Live Master 
Mute button

Live Line-Out 
Mute button

Live Decibel scale

Preview Master 
Volume 

Preview Line-Out 
Mute button

Preview Decibel scale
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Main Shot List
Normally, the Main Window displays the shot list at the bottom of the window. 
However, you can hide the shot list display by unchecking Main Shot List in the Layout 
Menu. This is useful if you want to open up multiple Shot List Layer windows.

Control/Status Bar
Control buttons and status information are displayed at the top of the Main window.

Wirecast displays the following controls and statistics:

• Stream button Click to begin streaming. 

• Streaming time This displays how long you have been streaming. This value does 
not reset when you start/stop the broadcast. It is cumulative. This enables you to 
save portions of a broadcast to disk and still know the total amount of time.

• Record Button Click to begin recording.

• Recording Time This displays how long you have been recording. This value does 
not reset when you start/stop the broadcast. It is cumulative. 

• Gear Icon This is an Output Settings shortcut. Click to open the Output Settings 
window. (Same as selecting Output > Output Settings).

Stream button

Recording time

CPU Usage

Frames per 
second

Connection
Record button

Streaming time

Gear icon

Bitrate
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• Frames per Second Displays the broadcast frame rate (FPS).

• Bitrate Displays the broadcast bitrate (kilobits per second).

• CPU usage (percentage) This displays the current load on your CPU when 
streaming or recording in percent of usage. The encoder affects the CPU usage 
more than any other parameter in Wirecast. If this value is high, you should use a 
different encoder, or modify your encoder settings. If the CPU usage is near 95%, 
use a lower quality video output to lower the bandwidth.

Note: To avoid decrease in video quality, Wirecast should not be used at CPU usage 
above 80%. See the Telesteam Web site for suggested configurations.

• Connection This displays the current connection quality.  The bars indicate the 
amount of buffer memory used.  High bar count reflects low buffer use (good 
connection). Low bar count reflects high buffer use (poor connection and in danger 
of broadcast errors).  When one orange bar is displayed, the buffer is full. 
Wirecast User Guide | 142779
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Layers

           

Wirecast displays five layers in the Main Shot List window. They are numbered 1 
through 5 along the right side of the window. Each layer contains shots that can be 
selected by clicking them. A red LED light indicates that a shot is Live. (If AutoLive is 
turned on, when a shot is selected it is displayed in the Live window.) If you select 
multiple shots -- by selecting shots on multiple layers -- they will all be displayed in the 
Live window. But the shots are displayed in a layering manner, where layer 1 is on top 
and layer 5 is at the bottom (and layers 2 through 4 are layered in between). In the 
example below, the Logo in layer 2 is displayed on top of the River shot in layer 3.

STUDIO

Layer numberingRed LED lights

Layered shot 
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Layer Windows

           +

You can also open the Shot List in a separate window. Select Window > New Layer 
Window to display a list of the layer windows you can open (Master Layer 1 through 5). 
Select the layer you want to open and a new, separate layer window is displayed. 

      

This panel works exactly like the Shot List panel in the Main window, but enables you to 
open multiple layer panels. You can change which layer is displayed on each panel by 
selecting the Windows menu and selecting a different layer. 

Scripting APIs
Wirecast provides scripting which enables you to control and automate the Wirecast 
environment. 

Scripting is all handled via AppleScript. To access the documentation, open up Apple 
Script Editor (select Applications -> Utilities -> Apple Script Editor), then select File -> 
Open Dictionary, and select the /Applications/Wirecast.app bundle from the list.

STUDIO
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 Installation
Introduction
This topic guides you through installing (or upgrading) and activating Wirecast.

Topics
 Installing

 Activating

 Uninstalling

Installing
To install Wirecast, follow these steps:

1. Download the installer from the Website at:
http://www.telestream.net/wirecast/overview.htm.

Note: During installation, you will be asked if you want to install the Virtual 
Microphone feature. If you do (recommended), check the displayed check box and 
continue the installation. Installing Virtual Microphone requires administrative rights.

2. Run the installer (.dmg) program.

3. Click Agree to the license terms.

http://www.telestream.net/wire-cast/overview.htm
http://www.telestream.net/wire-cast/overview.htm
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4. Open the Wirecast in the downloads folder, then click and drag the icon into the 
Applications folder. If a version of Wirecast already exists, the installer asks you if 
you want to replace the previous version.

      

Activating
When you purchased Wirecast a serial number was provided. This serial number must 
be registered in the Wirecast program to unlock the features of Wirecast. To register 
Wirecast follow these steps:

1. Run the Wirecast program.
Wirecast User Guide | 142779
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2. Select Preferences from the Wirecast menu, select Licenses, then click Purchase 
License.

     

3. Enter your serial number. (If you do not have a license, click Purchase to purchase a 
license on-line.)

    

4. When the unlocked message displays, click OK.

5. Close the Preferences window.

Your Wirecast program should now be fully activated.

Uninstalling
1. To uninstall Wirecast, place the Wirecast program in the Trash folder.

System Requirements
Wirecast

• Operating Systems: OS X 10.9 Mavericks and OS X 10.10 Yosemite 
(Wirecast 6 does not support OS X 10.8 or previous versions)

• Mac computer with Intel Core 2 Duo processor

• Core i5 or later recommended for 720p streaming

• Core i7 recommended for 1080p streaming

• 2GB RAM minimum

Select License

Click Purchase 
License

Enter your serial number

Click OK
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• 4GB recommended for 1080p streaming

• 200MB free hard drive space for installation

• Hard drive space for recording to disk

• Compatible Flash streaming server, or account with a supported Flash streaming 
portal required for Flash H.264 streaming

• 512 MB PCI-Express graphics card with 3D acceleration

• GeForce or Radeon class card recommended

• Sufficient upload speed for streaming

• Minimum recommended is twice the bandwidth of the total bit rate of the stream 

Desktop Presenter

• Use the remote version of Desktop Presenter 2.0.5 with Wirecast 6.0; it's available as 
a separate download at:   http://www.telestream.net/purchase/store.htm.
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Tutorials
Introduction
The best way to get started using Wirecast  is to quickly work through all its main 
features. This tour presents a series of three tutorials, each designed to help you 
understand how to create and broadcast presentations using Wirecast. 

As you work through these tutorials, you will also become familiar with important 
Wirecast concepts and how you can use them to deliver high quality broadcasts. The 
more you know about Wirecast, the better it will serve your broadcasting objectives.

Because each tutorial builds on the skills and knowledge you learn in the previous 
tutorials, it is recommended that you take the tutorials in succession. Working through 
all the tutorials takes about thirty minutes.

As you gain hands-on experience creating video and audio presentations - which leads 
to a working knowledge of Wirecast and its components and architecture - you will 
gain proficiency in using Wirecast.

Tutorials
 Tutorial 1: Basic Concepts

 Tutorial 2: Editing Shots

 Tutorial 3: Broadcasting

Note: You can run all of the tutorials without a license. However, a watermark on the 
video and an occasional voice-over on the audio are present until a valid license is 
activated. 

Note: For licensing information, select Preferences from the Wirecast menu, select 
License, then click Purchase License. Or, you can contact sales@telestream.net.

mailto:sales@telestream.net
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Tutorial 1: Basic Concepts
The goal of this tutorial is to provide you with a quick but successful experience 
creating and broadcasting a presentation using Wirecast. 

This tutorial requires that you open the tutorial document in Wirecast. To do this, select 
Create Document for Tutorial from the Help menu in Wirecast. 

Note: If you are running the tutorial with Wirecast in demonstration mode, the 
Wirecast logo appears from time to time and audio output has a periodic voice-over.

Tutorial Prep
To prepare for this tutorial you need to make two changes.

First, select Switch >Auto Live to turn on the Auto Live option. But also select Layout > 
Preview to turn off the Preview option. Both of these options will be changed back later 
in the tutorial. 
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The Wirecast Main Window shows the AutoLive LED as turned on.

+

AutoLive LED on
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The Main Window
Wirecast has two main display areas: Live Broadcast and Shot List. The Live Broadcast 
area is in the upper portion of the window displaying what Wirecast broadcasts to your 
viewers (or what it records to disk). The Shot List, in the lower half of the window, 
displays the shots available for broadcast.

What Is a Shot?
Wirecast uses the concept of a shot to construct presentations. A shot contains media, 
along with the settings for that media. In its simplest form, a shot contains one piece of 
media such as a photo or a video clip. But it can also be something more complex, like a 
live camera with a title, and background music, or even a Playlist of shots.

A shot can be edited and its settings can be changed (See Tutorial 2: Editing Shots). 
Shots are important because they enable you to configure a lot of information before 
you broadcast your presentation. This enables you to concentrate on creating a good 
production during your broadcast. 

Live Broadcast Area

Shot List
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Switching Between Shots
Individual shots are displayed in the Shot List. Click the Ripples shot in the Shot List area 
and the image fades into the Live Broadcast Area display. This is called “taking a shot 
live”. 

Shot in Live Broadcast Area

Click Ripples
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Click the shot labeled Blank Shot and the Ripples image fades to a blank screen. The 
Blank Shot enables you to display nothing, which is sometimes useful. 

Transitions
In the previous examples, a fade occurred when you clicked on a shot. This is because a 
smooth transition is the default. 

Transition controls are located just below the Live Broadcast Area where two kinds of 
transitions are shown: Cut and Smooth.

When Cut is selected, transitions are immediate. When Smooth is selected, transitions 
fade in (as demonstrated above).

There are more than just two kinds of transitions to choose from, but only two can be 
assigned to the Transition Panel. To select a different transition type, click the small 
arrow on the right side of either transition button. When the list appears, select a new 

Blank Shot in Live Broadcast Area

Click Blank Shot
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transition to assign to the button. You can also click the transition button and drag the 
mouse downward until the menu of selections is displayed.

For example, to change the first transition button from Cut to Swoop, click the Cut 
button and dragging downward until the menu appears. select Swoop from the menu. 
Swoop should now be selected for the first button. 

Now click back and forth between River and Ripples using Swoop.

These two transition buttons can also be selected by using the following key 
combinations: Command+1 and Command+2. 

Transition Speed 
You can also control how fast a transition occurs, by selecting the Switch >Transition 
Speed. Your choices range from Slowest to Fastest.

Go Button 
The Go Button (or Command+G) enables you to make a transition.

Clicking the Go button does nothing when Wirecast is in AutoLive mode. The only 
exception is that it will update a live shot if you have made changes to it using the Shot 
Editor. Later in this tutorial you will discover how to use the Go button to transition 
between different shots when AutoLive is off.

Click arrow to open menu

Select a transition type

Go button
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Layers 

Note: Before you start this section, please select Smooth as your transition.

              

Wirecast enables you display several shots in the Preview and Live windows at the same 
time by rendering them one on top of another according to Wirecast's Layer system. 
This is an excellent way to add and remove objects in your broadcast. 

Wirecast displays five layers in the Main Shot List window. They are numbered 1 
through 5 along the right side of the window. Each layer contains shots that can be 
selected by clicking it. A red LED light indicates that a shot is selected. When a shot is 
selected it is displayed in the Live Broadcast window. If you select multiple shots (by 
selecting a shot on more than one layer) they will all be displayed in the Live Broadcast 
window. The shots are displayed in a layering manner, where layer 1 is on top and layer 
5 is at the bottom (and layers 2 through 4 are layered in between). 

Select the Logo shot in layer 2 and the River shot in layer 3. The result is a layered shot 
containing both images.

STUDIO

Layer numbersSelect River 
shot

Layered shot 

Select Logo 
shot
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Layers are displayed in a particular order: Layer 1 is on top, Layer 2 below it,  Layer 3 
below Layer 2, etc. This tutorial, so far, has been operating on Layer 3. Blank, Ripples, 
River shots and Movie shot are on Layer 3 (as seen previously in this tutorial), but Layer 
2 has only a logo and a blank shot.

    

Each layer can be turned on or off by clicking the white LED light on the far right side of 
the layer window. Click the Layer 2 LED to remove the Logo shot. 

Click the LED again to turn Layer 2 back on.

Auto Live 
So far in this Tutorial, Wirecast has been running in AutoLive mode. What this means is 
that any change you make in the Shot List is automatically made live in your Broadcast. 

Master Layer 3

Click to turn Layer 2 off

Logo removed
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This mode is very useful for those users who want to set up all of their shots at once and 
then single-click them as they run their presentation. But the disadvantage of this 
single-click method is that you can only see one shot change at a time. Once you click a 
shot, your viewers also see it (with no preview of how it looks on your part). 

Turn AutoLive Off 
An LED light, next to the Go button is lit when you are in AutoLive mode.

Make sure AutoLive is off by unchecking AutoLive in the Switch menu. A dialog box is 
shown informing you that AutoLive is off and transitions must be made using the Go 
button. Click OK in the dialog box to continue. 

Try clicking the Ripples and River shots. Nothing happens because AutoLive is off. Now 
click the Ripples shot and click the Go Button. The Ripples shot is taken live in the Live 
Broadcast window. Click the River shot and, as expected, nothing happens. Click the Go 
button again and the River shot becomes Live. 

Note: When AutoLive is off, you must always click the Go button (or press the 
Command+G keys) to display the selected shot in the Live Broadcast Area. 

AutoLive LED
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Multiple Changes
The benefit of having AutoLive off is that you can make several changes first and then 
have them occur all at the same time. To do this, first verify that AutoLive is off. Click 
Sample Title in layer 1, click Blank Shot in Layer 2, and click the Ripples Shot in Layer 3. 
Click the Go button (or Command+G) to make the Ripples and Sample Title shots live at 
the same time.

Preview 

              

One problem you may have noticed while running this tutorial is that you cannot see 
the changes you are making before broadcasting them. To solve this problem, Wirecast 
enables you to see a preview of what you broadcast. 

Select Sample 
Title

Select Ripples Layered shotsClick Go button

Select Blank 
Shot

STUDIO
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Select Preview from the Layout menu. A preview window is displayed to the left of the 
Live Broadcast window. 

Click the River shot on Layer 3. The River shot is displayed in the Preview window. The 
Preview windows uses a green LED light to identify it. The Live Broadcast window uses 
a red LED. When shots are selected they display a green or red LED to indicate selection 
for preview or live broadcast.

    

Preview window

Sample Title and Ripples  
selected for Live window

River selected for 
Preview window
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Click the Go button to make the River shot live. Click Blank Shot in Layer 1 to remove 
the title from the ripples shot. 

Note: Taking a shot live will set the Master volume slider to the value of the Preview 
volume slider.

Click Blank Shot

Click Go button
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Click the Go button again to make the Ripples Shot live. Notice that the Ripples and River shots LED’s 
have change color because the Preview and Live windows exchanged images. This lets you know what 
your last live window looked like as you prepare your next shot in the Preview window. 

Tutorial 2: Editing Shots
The first tutorial used only the Main window, and explained various ways in which you 
can use an existing shot. But shots can also be created and edited. This tutorial 
demonstrates how to edit your shots.

Shot LED’s 
changed color

Click Go button again
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You create shots for use in broadcast presentations. Shot editing enables you to make 
shots you need for your broadcast. Shots can be configured in different ways. Some 
shots have only titles and some just a logo, others may have only a picture. When you 
broadcast you are choosing -- in real time -- the shot you want to display.

Note: Before you start this tutorial, create a new tutorial document by selecting 
Create Document Tutorial from the Help menu. You should see a new Main window as 
shown below.

Shot Editor Overview
Double click the Ripples Shot. This opens the Shot Editor window. 

Note: If you save a document with the Shot Editor window open, Wirecast 
remembers this and re-opens the edit window when the document is re-opened. 
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The Shot Editor window has three main areas: Shot Preview, Configuration Area, and 
Source Layers.

Shot Preview This area shows exactly what this shot looks like to your viewers when 
you take this shot live. 

Configuration Area This is where you make changes to the content of the shot, and set 
its parameters. The configuration area changes appearance depending on the selected 
Source Layer. 

Source Layers This area enables you to add, remove, and reorder the sources in your 
shot. Sources are ordered visually from top to bottom. For example, the first source in 
the Source Layer List appears on top of all other sources in the preview. This list also 
controls visibility of each of the elements in the shot. 

Shot Preview

Configuration Area

Source Layers
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Source Layers 
The bottom left part of the Shot Editor window lists the sources that make up your shot. 

Click on the Logo icon (source) in the Configuration Area. Notice that the Logo is 
displayed in the Shot Preview area. Click the Ripples icon (source) and the Preview 
switches to Ripples. This is how you change the source media for this layer in the shot. 

Template Window
The Template window icon is located in the controls bar in the middle of the window. 

Click on the template window icon to open the Template window. Select the Angled In 
template and click the Apply button: 

Notice the Preview has changed again in the Shot Editor window, and now shows the 
Ripples image on the Left side. This is because the template selected has an A and a B 

Source 

Template icon

Select Angled In

Click Apply
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portion to it. Two different sources can be assigned to A and B, but for now only A is 
assigned (with the Ripples source):

Sources in Wirecast can be assigned either A, B or C in the Source Layers list. To change 
the assignment, click the A (or B or C) icon and make a selection. This makes choosing a 
new template much simpler because Wirecast automatically positions the correct 
sources on screen.
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For example, to change the media for the source that is identified as B, select the source 
identified as B, then click the River icon in the Configuration area. Your Preview should 
now look like this: 

Click on the 
B source

Click on the 
River icon

River source is 
displayed as B
in Preview
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Titles 

                 

You can also add a title to a shot. First click the plus (+) button on the bottom of the 
Source list to add a new layer: 

To add a title template, click the T button on the control panel: 

STUDIO

Click the 
plus button

New source 
layer added

Click T button
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Select the title template called Blue Banner 3 (items are not listed alphabetically) and 
your preview adds the title: 

Next, click the T icon in the Attributes bar to enable text editing: 

Blue Banner 3 
displayed

Select Blue 
Banner 3

Click T 
icon
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Type text into lines 1 & 2 to display it in the preview window: 

Effects/Motion 

Positioning Objects 
The sources in a shot can be positioned anywhere on the screen. Make sure Blue 
Banner 3 is selected. Click the Effects icon in the Shot Editor. 

Though the title element is initially placed in the bottom middle of the Preview screen, 
it can be moved anywhere. To move the title, click and drag it to a new location. You can 

Type two 
lines of text

Text lines 
displayed

Click the 
effects icon

Select Blue 
Banner 3
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also move the title to an edge, corner, or center by clicking on one of the repositioning 
buttons in the configuration area:

You can also resize or rotate the title. 

To resize the title (while respecting aspect ratio), hold the Command key down while 
moving the mouse vertically. To resize (independent of the aspect ratio), hold the 
Command key and the shift key down while moving the mouse vertically and 
horizontally. The Respect Aspect Ratio checkbox in the configuration area must be 
unchecked.

To rotate the title, hold down the Option key while moving the mouse vertically and 
horizontally. 

Click a button to move an element
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Motion for Objects 
All objects (including the title) can have motion assigned to them. Click the Motion tab, 
to open the Build-In/Build-Out configuration panel: 

Motion only occurs during a transition (when you click Go, or click a shot in AutoLive 
mode). Motion defines how to add (Build-In) or remove (Build-Out) a shot element. 

There are two forms of Motion: 

1. Build In (add) Build In motion occurs when the shot is added to the Live Broadcast 
display. 

2. Build Out (remove) Build Out motion occurs when the shot is removed from the 
Live Broadcast display. 

Changing Motion Options 
Click the menu under Build In in the configuration area and select From Left. Also check 
the Decelerate In checkbox: 

Click the 
Motion tab

Build In / Build Out 
configuration panel

Select “From Left”

Check Decelerate In
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To see this behavior in action, you must go back to the Main window and trigger the 
Build In action. To do this, follow these steps:

1. Close the Shot Editor window (optionally) by clicking the X in the corner of the 
window.

2. In the Main window, make sure Smooth transition is selected. 

3. Click on the Blank Shot, then click the Ripples shot (recently edited). Notice that 
when the Title appears it comes in from the left. 

Tutorial 3: Broadcasting
This tutorial demonstrates how to setup and broadcast your Wirecast presentations. 
You can broadcast to a specific computer (Unicast), multiple viewers (Multicast), or 
even record your broadcast to disk.

There are two main components for broadcasting your presentation (or saving it to 
disk): Encoding and Destination.

You need to decide how you are going to encode the broadcast. Encoding is the type of 
compression used (JPEG, MPEG4, etc.). Wirecast comes configured with many common 
encoding options.   (see The Encoder Presets Window)

A destination for the broadcast must be selected. You can send it to a server for 
broadcast or save it to disk. Your destination is your  Streaming Service.

Streaming
You can stream your broadcast to any streaming service provider you choose. The 
Broadcast section of this user guide provides details on how to do this for many 
popular providers. This tutorial will show how to stream to Bambuser.

To stream to Bambuser (as an example), follow these steps:

1. Select Bambuser from the Destination menu.

2. Select an encoder. 

3. Enter your Bambuser username.

4. After you have entered your username, click Authenticate to enter your password 
and generate the RTMP URL. You only need to do this one time because Wirecast 
stores the channel information for future streams. The default RTMP port is 1935. 
You may need to configure your firewall to enable connections on this port.

Note: If you do not have a username and password, you can sign up with Bambuser 
by clicking the Bambuser icon or by clicking Sign Up.

5. Select your Bambuser channel.

6. Optionally, enter a Stream Delay value. This provides a time buffer between your 
live stream from Wirecast and the actual broadcast itself. You can set the delay from 
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0 to 999 seconds. However, greater delays require greater memory use. The amount 
of memory used is displayed when you enter the amount of delay.

7. Click OK. 

    

To stream your presentation, click the Stream button at the top of the Main window.

    

If you have not already selected a destination and logged into it, a dialog box displays. 
Select a destination, log in when asked to do so, then click OK. 

        

Select an encoder 

Select Bambuser

Click Authenticate 
and enter 
password

Select Channel

Enter user name

Click Stream Click Record

Select Destination

Click OK
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The Stream LED will blink until a connection is made. Once you are connected the LED 
turns full on and a red box is placed around the Stream button. If you cannout connect 
an error message will display. 

        

Connection strength bars are displayed on the right. Fewer bars indicates a weaker 
(slower) connection.

        

If the connection is ever broken, the green bars are reduced to a single red bar, then 
immediately a no connection icon is displayed in place of the bars.

        

When the connection recovered, the no connection icon is replaced with the green bars.

Click Stream again to stop streaming. You can also record your broadcast by clicking 
Record.

Red LED and red box

Green connection 
strength bars

No connection icon
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Main Window
Introduction
This section describes in detail how to use Wirecast’s main window.

Topics
 Overview

 Control/Status Bar

 Preview / Live Broadcast Area

 Countdown Clock Display

 Transition Controls

 Shot Tool Menu

 Shot Selection Area

 Layers

 AutoLive

Overview
Wirecast’s main window is comprised of these display areas: 

• Controls/Status Area The top area with the Stream and Record buttons.

• Preview/Live Broadcast Area The large area in the center.

• Transition Controls The area with the Transition (Cut and Smooth) and Go buttons.
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• Shot Selection Area The area displaying the shot icons (available shots).

Control/Status Bar
Control buttons and status information are displayed at the top of the Main window.

Wirecast displays the following controls and statistics:

• Stream button Click to begin streaming. 

Controls/status areaPreview/Live Broadcast area

Transition controlsShot selection area

Stream button

Recording time

CPU Usage

Frames per 
second

Connection
Record button

Streaming time

Gear icon

Bitrate
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• Streaming time This displays how long you have been streaming. This value does 
not reset when you start/stop the broadcast. It is cumulative. This enables you to 
save portions of a broadcast to disk and still know the total amount of time.

• Record Button Click to begin recording.

• Recording Time This displays how long you have been recording. This value does 
not reset when you start/stop the broadcast. It is cumulative. 

• Gear Icon This is an Output Settings shortcut. Click to open the Output Settings 
window. (Same as selecting Output > Output Settings).

• Frames per Second Displays the broadcast frame rate (FPS).

• Bitrate Displays the broadcast bitrate (kilobits per second).

• CPU usage (percentage) This displays the current load on your CPU when 
streaming or recording in percent of usage. The encoder affects the CPU usage 
more than any other parameter in Wirecast. If this value is high, you should use a 
different encoder, or modify your encoder settings. If the CPU usage is near 95%, 
use a lower quality video output to lower the bandwidth.

Note: To avoid decrease in video quality, Wirecast should not be used at CPU usage 
above 80%. See the Telesteam Web site for suggested configurations.

•
• Connection This displays the current connection quality.  The bars indicate the 

amount of buffer memory used.  High bar count reflects low buffer use (good 
connection). Low bar count reflects high buffer use (poor connection and in danger 
of broadcast errors).  When one orange bar is displayed, the buffer is full. 

Preview / Live Broadcast Area

                      

When you open a new document, if you are not licensed for Studio or Pro, only the Live 
area displays. The Live area shows what is broadcast to your viewers before the 
encoding or compression. If you are licensed for Studio or Pro, the Preview window is 
displayed by default.

When AutoLive is off, you can make several changes without your viewers seeing the 
change. This is most useful when you are using an engineer to run your broadcast. 
When you are making changes to your broadcast, you may want to see those changes 
before broadcasting them. Preview allows you to do this.

STUDIO
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To see the preview, select Preview from the Layout menu. This sets up the Main Window 
with the Preview Area on the left and the Live Broadcast Area on the right. Clicking the 
Go button makes the Ripples shot become Live.

Preview Area Live Broadcast Area
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Countdown Clock Display
The Main window displays a countdown clock whenever a video shot is playing. If you 
have multiple video shots playing, click the gear menu icon to select which shot will be 
associated with the countdown clock.

Transition Controls
The transition area is in the middle of the Main Window: 

There are two Transition buttons, but each can be configured to present one of many 
possible transition types. In the image above, the two configured transitions are: Cut 
and Smooth. Since Smooth is selected (button darkened), any transition executed by 
clicking Go is a smooth transition. 

Changing Transitions
If you click the Cut button, it becomes selected and making it the current transition 
type: 

You always have two different transition types available. You can also select one of the 
two buttons by pressing Command+1 or 2 keys for the two transition types displayed.

Gear iconCountdown clock
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If you click the down-arrow on the right side of either transition button, you can select a 
new transition to assign to that button.

Transition Speed
The transition speed is set by selecting Switch > Transition Speed. There are five settings: 
Slowest, Slow, Normal, Faster, and Fastest.

Go Button 
The Go Button (or Command+G) enables you to make a transition occur at any time.

Clicking the Go button does nothing when Wirecast is in AutoLive mode, except to 
update a live shot if you have made changes to it using the Shot Editor. 

Transition Editing
Some transitions have parameters that can be changed. To edit these parameters, 
select Edit Transitions from any of the three transition button drop-down menus (Cut, 
Smooth, etc.). Select the transition you wish to edit from the drop-down menu. Modify 

Click arrow to open menu

Select a transition type

Go button
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the displayed parameters as required. Each transition type has its own set parameters. 
Click OK when finished.

Shot Tool Menu
The Shot Tool Menu provides a way to open lives sources, file sources, the Desktop 
Presenter program, shot graphics, shot audio, and shot templates. The Shot Tool Menu 
is the circle to the right of the shot icons.

When you hover over the Shot Tool Menu it displays four menu items. Hover over and 
click a menu item to open it.

There are four menu items: 

Live Sources 
Click the Live Sources button to display a list of live sources under the categories: 
System Device, Web streams, and Scoreboard. When a live source is selected, it is added 
to the Shot Selection area as a new shot.

Transition select menu

Modify parameters

Click OK

Shot Tool Menu

Hover over and 
click a menu item

Shot Audio

File Sources

Live Sources

Desktop Presenter
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Shot Audio
Click the Shot Audio button to add an audio file shot. When selected a dialog window 
displays enabling you to navigate to and select a file.

Desktop Presenter 
To start Desktop Presenter, under the Sources menu select either New Remote Destop 
Presenter or New Local Destop Presenter. Remote Desktop Presenter presents a desktop 
from another computer in Wirecast. Local Desktop Presenter allows you to present a 
portion or all of the desktop of the computer where Wirecast is running.

You can also start DTP (local or remote) from the Shot Tool Menu.

File Sources 
Click the File Sources button to display a list of file-based source categories: Video Shots, 
Picture Shots, Music (audio) Shots, or a New (empty) Shot. When selected a file 
selection dialog window displays enabling you to navigate to and select a file to 
become a shot. Select Add New Shot to add a new, untitled, generic shot without any 
file-based resources attached.

Shot Selection Area 
The bottom part of the Main Window contains the Shot Selection Area, also called the 
Shot List. 

The shot icons can be made to display any live activity in the device it represents 
(cameras, streaming, etc.). See Performance in the Preferences section.

Shot selection area
Wirecast User Guide | 142779



Main Window
Shot Selection Area

69
Changing Shots
Right-click on any shot to display the shot menu.

Change Source Select Change Source to change the source of your shot. Upon 
selection, a menu of sources will display enabling you to make a selection.

Change Audio Select Change Audio to change the audio of your shot. Upon selection, 
a menu of audio sources will display enabling you to make a selection.

Right-click shot

Select source

Select Change Source

Select audio

Select Change Audio
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Change Template Select Change Template to change the template of your shot. Upon 
selection, a menu of templates will display enabling you to make a selection.

Keyboard Shortcut You can create a keyboard shortcut to any shot. To do this, select 
Keyboard Shortcut, then select a menu number to associate with that shot. After you 
have selected a menu number, that menu item is checked and the number is displayed 
in the shot icon.

To take a shot using the assigned hotkey, press the number key assigned to that shot.

You can assign multiple shots to the same menu number as long as they are on 
different layers. When you use the assigned hotkey all the shots assigned to it will be 
taken. Selecting a checked menu item will uncheck it and unassign the shot.

Select Unmap All Keys to remove all hotkey assignments.

Edit Shot You can edit a shot by double-clicking on it, by right-clicking it and selecting 
Edit Shot, or by selecting Edit Shot from the Edit menu. You can also edit a shot by 
selecting it and pressing the Command+E keys.

Select Template

Select Change Template

Select Keyboard Shortcut

Select a menu number

Menu item checked
Menu number displayed
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Rename Shot You can rename a shot by right-clicking it and selecting Rename Shot, or 
by selecting Rename Shot from the Edit menu. You can also rename a shot by selecting 
it and pressing the Command+R keys.

Duplicate Shot You can duplicate a shot by right-clicking it and selecting Duplicate 
Shot, or by selecting Duplicate Shot from the Edit menu. You can also duplicate a shot 
by selecting it and pressing the Command+D keys.

Delete Shot You can delete a shot by right-clicking it and selecting Delete Shot, or by 
selecting Delete Shot from the Edit menu. You can also delete a shot by selecting it and 
pressing the Command+Backspace keys.

Moving a Shot to Another Layer
You can move a shot to another layer by selecting Move to Layer from the Edit menu, 
then selecting the target layer from the drop-down menu. Or, you can right-click the 
Shot and select Move to Layer. You can also drag the shot to a different layer. 

When shots are created, they are assigned to a specific layer. They exist on that layer 
until they are moved or deleted. (See Layers.)

Resizing the Shot Icons
You can resize the shot icons on any layer by clicking the up or down arrow on the left 
side of the layer window. Click the up arrow to make all the icons larger; click the down 
arrow to make them smaller. Clicking the down arrow when the shot icons are in their 
smallest state causes the layer window to become hidden. 

To un-hide a layer window, click the side arrow that is displayed.

Layers 

                             

Wirecast allows you to put shots on any of five different layers. Layering shots enables 
Wirecast to merge them together, from back (lowest layer) to front, to form a single 
visual image during broadcast. 

Click up or 
down arrow 
to resize

Click side 
arrow

STUDIO
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When Wirecast first opens, two of the five layers of shots are displayed. You must scroll 
down (or expand the window) to see the other three layers. 

What is a Layer? 
Layers are, by default, named 1 through 5. Layers determine the order when presenting 
images in the Live Broadcast Area. The Bottom layer (5) is drawn first, then the other 
layers are added, in order, up to Layer 1. Using multiple layers is a powerful way to show 
a company logo, a background, or a title, independent from each other. 

Shot Layer 1

Shot Layer 2

Shot Layer 3

Shot Layer 4

Shot Layer 5
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Changing Layers
To select a layer, click its LED to turn it on (click it again to turn if off ). When a layer is 
selected, the selected shot in that layer is displayed in the Preview/Live Broadcast area.  
If multiple layers are selected all selected shots are displayed.

Moving a Shot to Another Layer
A shot can be moved to another layer by clicking and dragging the shot from one layer 
to another within the Main Shot window. When shots are created, they are assigned to 
a specific layer. They exist on that layer until you move them or delete them. 

Layer Zooming
You can zoom in on any layer, enabling you to see the icons more clearly. To do this click 
the up or down arrow on the left side of the layer window. Click the UP arrow to make 
all the icons larger (zoom in); click the down arrow to make them smaller (zoom out). 

Click LED to select layer

Layered display
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Clicking the down arrow when the shot icons are in their smallest state causes the layer 
window to become hidden. 

To un-hide a layer window, click the side arrow that is displayed.

AutoLive
AutoLive is turned on and off by selecting Switch > AutoLive (or by pressing the 
Command+L keys). When AutoLive is on, changes made in the Shot List are 
automatically taken Live in the broadcast (using the current transition and duration). If 
you click a shot when AutoLive is off, the shot is not sent to live broadcast. In this mode 
you take the shot live manually, by clicking the Go button, or by pressing the 
Command+G keys.

Live Icons
You can, optionally, make your live source icon display its source (camera, Web stream, 
etc.) in real time. This means that inside the icon, you will see what the live source sees.

To turn on the Live Icon option (on by default), select the Performance tab in 
Preferences, then check the Live Icons checkbox. You can also adjust the frames per 
second rate of the display using the slider. Lower FPS rates reduce the time taken to 

Click up or 
down arrow 
to resize

Click side 
arrow

Live source icon
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adjust the live icon display. Higher FPS rates provides a smoother display of the live icon 
source. 

     

Check to turn on

Slide to set FPS
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Keyboard Shortcuts
Introduction
This section provides a list all of keyboard shortcuts used in Wirecast. They are arranged according to 
how they appear in the drop-down menus in the main window.

General Shortcuts

* See Keyboard Shortcut in Changing Shots.

WirecastUstream Menu

Misc Shortcuts Keyboard Shortcut
Display Shot <shot number key*>
Spacebar Left-hand transition button
Enter Right-hand transition button
i Sets the media IN point
o Sets the media OUT point
e Sets the Replay IN point
r Creates a Replay shot
= Increments Home score
- Decrements Home score
] Increments Visitor score
[ Decrements Visitor score

Wirecast Menu Keyboard Shortcut
Preferences command+comma
Hide Wirecast command+H
Hide Others control+command+H
Quit Wirecast command+Q
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File Menu

Edit Menu

Switch Menu

Media Menu

Source Menu

Output Menu

Layout Menu

Replay Menu

Social Menu

Window Menu

Help Menu

File Menu Keyboard Shortcut
New command+N
Open command+O
Import Media command+Shft+I
Save command+S
Save As command+Shft+S
Close Window command+W

Edit Menu Keyboard Shortcut
Undo command+Z
Redo command+Shft+Z
Cut command+X
Copy command+C
Paste command+V
Select All command+A
Edit Shot command+E
Rename Shot command+R
Duplicate Shot command+D
Delete Shot command+Delete

Switch Menu Keyboard Shortcut
Go command+G
Cut command+1
Smooth command+2
AutoLive command+L

Media Menu Keyboard Shortcut
Start Playing All Movies command+P
Pause All Movies command+Shft+P
Play to Next Point command+RightArrow
Jump to Previous Point command+LeftArrow

Source Menu Keyboard Shortcut
Show Source Settings control+command+S

Output Menu Keyboard Shortcut
Output Settings command+Y
Start/Stop Broadcasting > Start All command+B
Start/Stop Recording > Start All command+K

Layout Menu Keyboard Shortcut
Preview control+command+P
Master Audio control+command+M
Main Shot List control+command+L
Go to Layer > Master Layer 1 command+T
Go to Layer > Master Layer 2 command+F
Go to Layer > Master Layer 3 command+N
Go to Layer > Master Layer 4 command+B
Go to Layer > Master Layer 5 command+A

Replay Menu Keyboard Shortcut
e Replay Mark In
r Create Replay Shot

Social Menu Keyboard Shortcut
NO SHORTCUTS

Window Menu Keyboard Shortcut
Minimize command+M
Inspector command+I
Encoder Presets control+command+E
New Layer Window > 
Master Layer 1

command+T

Help Menu Keyboard Shortcut
NO SHORTCUTS
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Adding Media
Introduction
In addition to live video from your cameras, Wirecast enables you to work with media 
created outside of Wirecast. This section introduces some common media types you 
can use with Wirecast.

There are three ways to add media to Wirecast: 

1. Drag & drop into a new shot. The simplest way to add media to a shot is to drag & 
drop the media directly into the Shot List in the Main window.

2. Drag & drop into an existing shot. To add media to an existing shot, drag & drop 
the media directly into the Shot Editor's media list.

3. Select directly. You can add media by selecting Import Media from the File menu, 
by pressing the Command+Shift+I keys, or by clicking the plus (+) button in the 
Shot Editor.

Topics
 Images/Opacity

 Keynote Movies

 Supported Codecs

Images/Opacity
Wirecast supports a wide variety of still images types (TIFF, GIF, JPEG, PNG, etc.). Some 
of these formats offer some form of opacity (or transparency). This is often called an 
Alpha Channel. Wirecast works seamlessly with these formats making them the 
preferred methods for using graphics and logos, which have transparency.

GIF and Transparency
GIF files are a special case because they only offer transparency and not a true Alpha 
Channel. The GIF format enables you to define part of the image as transparent 
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(completely invisible), but does not enable you to define it as partially transparent. 
Some GIF images use transparency for much of the image. However, near the edges of 
the visible data, transparency cannot be used. This happens quite often when there is a 
shadow near the edges of the visible data. The author of the GIF often assumes a 
certain background color (white, for example) and that color becomes embedded in 
the actual image.

When Wirecast displays these types of images, the edges of the visible data shows the 
background that was saved in the GIF. This is not a defect in Wirecast and, therefore, 
Wirecast can only present the data as it exists in the GIF. The solution is to obtain the 
original image and re-save the image as either TIFF or PNG. Both of these formats offer 
full Opacity.

Keynote Movies
Wirecast supports some special features of Keynote Movies which enable you to move 
back and forth between the pages from within Wirecast. With this feature you can 
visually annotate and walk through your Keynote for your viewers.

Exporting from Keynote
To take advantage of these features within Wirecast, export the movie into a QuickTime 
file:

1. Open your presentation in Keynote.

2. Select Export from the File menu.

3. Choose QuickTime and click Next.

4. Choose Interactive Slideshow.

5. Click Export, enter your file name, then click Export again. 

Using Movies
To use the movie in Wirecast, follow these steps:

1. Drag & drop the Keynote movie into the Shot List in the Main Window.

2. Click the movie to take it live in the Live Broadcast Window. (Or, if you have 
AutoLive off, click the Go button.)

3. To go forward in the Keynote movie, select Play to next point from the Media menu 
(or, press the Command+Right Arrow keys). The Keynote movie plays to the next 
section using the transition you selected in Keynote.

4. To go backward in the Keynote movie, select Jump to previous point from the 
Media menu (or, press the Command+Left Arrow keys). All media in the Live area 
jumps to the previous point.
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Windows Media 
Windows Media Files (WMV and WMA) are not supported by Wirecast. The solution is to 
convert the media into a different type, such as MPEG-4.

Real Media
Real Media Files (.RM) are not supported by Wirecast. The solution is to convert the 
media into a different type such as MPEG-4.

Supported Codecs
Shown below is a list of supported video and audio codecs.

Video Codec MOV 
(M4V)

MP3 MPEG-4 
ISO (MP4)

WAVAIFF 
(AIFF, AIF) 

ASF 
(WMV)

AVC YES NO YES NO NO NO
H264 YES NO YES NO NO NO
DVC25 YES NO NO NO NO NO
DVCPRO50 YES NO NO NO NO NO
DVCPRO100 YES NO NO NO NO NO
MJPEG YES NO NO NO NO NO
ProRes YES 

(mac only)
NO NO NO NO NO

Windows Media 
Video

NO NO NO NO NO YES (windows)

Audio Codecs:
AAC YES NO YES NO NO NO
MP3 YES YES NO NO NO NO
PCM YES NO NO YES YES NO
Windows Media 
Audio

NO NO NO NO NO YES (windows)
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Titles
 Introduction

             

Wirecast offers a wide variety of title banner templates to use in your broadcast. Adding 
a professional looking title is as simple as selecting a template and adding your text.

Topics
 Adding Titles

 Modifying Titles

 Title Area

 Placing Titles

 Creating New Templates

Adding Titles
To add a title to a shot, double-click the shot to open it in the Shot Editor: 

   

STUDIO

Double-click a shot to edit
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Wirecast displays the shot you selected in the Shot Editor window: 

Adding New Source
To add a new source, click the plus (+) icon in the Sources Toolbar at the bottom-left 
corner of the Shot Editor window. Wirecast adds a new source entry, labeled [no media].

Newly added 
source

Source Toolbar

Click plus to add 
new source
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Using the tools in the Attributes toolbar and the Media Panel, you can configure your 
source so it displays as requires:

     

Configuring Titles
The basic configuration for a media source is a title bar with text captions. Other 
attributes are optional. As you configure the media, you can view your progress in the 
Preview area at the top of the Shot Editor window. To configure a title, follow these 
steps:

1. Select the Change Media icon in the Attributes toolbar. (Each time you create a new 
source, the media icon is selected for you). 

2. Click the T icon in the Media Panel to display titling templates. Scroll through the 
icons and select the banner graphic you want to use for a title. Be sure to select a 
title banner that is graphically designed to display the number of lines (1 to 4) you 
intend to use for this source. Wirecast provides many templates, but you can also 
create your own. 

3. Click on the Visual Effects icon in the Attributes toolbar to adjust the position of the 
banner, control its opacity and matting, and set other visual effects. Usually, no 
adjustments are needed.

4. Click on the Crop icon in the Attributes toolbar to crop the banner graphic as 
needed. As you adjust crop values, you can see the effect in the Preview window. 

5. Click the Text icon in the Attributes toolbar and enter up to 4 lines of text to display 
in the title. You can adjust paragraph formatting, font characteristics, and font color 
using the buttons to the right of each line. 

6. If you plan to chroma key the title, click the Chroma icon in the Attributes toolbar to 
enable and set up the chroma key. See Shot Editor Chroma Key to learn how to 
enable and configure chroma key settings.

7. Click on the Motion icon in the Attributes toolbar to set up your builds.

8. Click on the Filters icon in the Attributes toolbar to add and configure filters to use 
in this title. 

Attributes 
toolbar

Crop icon

Change Media icon

Text icon

Visual Effects icon

Config Media Settings

Motion icon

Chroma icon

Filter icon

 T icon
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Note: For more detailed information on the above steps, see Edit Menu.

Modifying Titles 
To modify the titles, you have to edit the shot. Double-click the shot to open the Shot 
Editor. Click the title attributes tool (T icon) in the Attributes toolbar. The title 
modification screen displays: 

Title Area
Depending on the title source selected, you can modify up to four lines of information. 
Each line of text has its own justification, font, and font color settings.

Changing Text
To change the text, enter the text into the text entry area for the line to be changed. 
Wirecast supports all text entry (even in-line entry engines for Japanese, Korean, 
Chinese, etc.).

Font Color

Font 

Justification
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Changing Justification
Justification is controlled by clicking on the justification icon and selecting left, center, 
or right from the drop-down menu. 

Changing Font
Click the font selection icon to open a font selection window. Click the icon again to 
close the font selection window.

The font selection window is a floating palette that changes the text as you make 
selections. So if you click in a different text entry area, the font panel notices this and 
configures itself to the settings of the new text entry area.

Note: The only items that Wirecast recognizes in the Font Panel are: Font Family, 
Typeface, and Size. All other settings are ignored by Wirecast 

Changing Font Color
Click the font color icon to change the color of the font. A standard font color selection 
window is displayed. Choose the color you desire and click OK.

Placing Titles
The previous sections describe how to create and edit a title for an existing shot. 
However, you can also create a shot which has only title data. This is very useful if you 
want to place the same title over several different shots or if you want to modify the 
title independent of the shot you are choosing. But you must decide, based on your 
type of broadcast, if you want your titles tied directly to specific shots or if you want 
them to be independent. Wirecast seamlessly supports both methods -- even both 
methods at the same time.

Seminar Title
You may want to broadcast a seminar and have the title of the seminar appear and 
disappear while switching between several other shots or cameras. In this case, create a 
shot which has only the title in it, enabling you to move this title to a Foreground layer. 
In this configuration, you can bring the title in and out of your broadcast by selecting 
between a blank shot and the title shot from your foreground master layer. By placing 
the title in this separate layer, it keeps it independent of the all other shots you have 
created.
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Interview Title
If you are broadcasting an interview, the shot which contains the camera for the 
interviewee may have a title in it. In this case, when you cut to the shot of the 
interviewee, the title appears. When you cut to the person asking the questions, the 
title does not appear because it is a different Wirecast shot.

Note: Since you can turn visibility of a title on and off inside the Shot Editor, you can 
still turn the title on and off in the shot. To turn it off, make the shot live, then open the 
Shot Editor. Click the shot icon and then click Go (or press Command+G). To turn it 
back on, click the shot icon again and click Go. 

Creating New Templates 
The templates that Wirecast uses are not editable within Wirecast. However, you can 
create new templates yourself using any graphics creation tool and an XML editor.

Example
Download the example custom templates from Telestream at:
 http://www.telestream.net/downloads/Wirecast/titles/Wirecast_User_Titles.zip.

Decompress this file and copy the XML and PNG files to:
~/Library/Preferences/Vara Software/Wirecast_User_Titles.

The next time you launch Wirecast, the user titles will be available. Any media used by 
these templates must exist in the same template folder. For example, if 
user_scoreboard.png is used in one of the example templates, it must be located in the 
Wirecast_User_Titles directory.

Other Media
Any media used by these templates must exist in the same template folder. For 
example, if user_scoreboard.png is used in one of the example templates, it must be 
located in the Wirecast_User_Titles directory.

Editing XML Files
There is an XML file called description.xml which describes all of your titles. Edit it to 
add, create, or delete titles. Read the header of the XML file for a list of rules and 
descriptions. Backup the file before editing because syntax errors cause Wirecast not to 
parse the file.

shot icon
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Logos
Introduction
When you perform a broadcast, you may want to include a company logo in your 
presentation. There are two ways you can do this in Wirecast: 

1. Global Logo (logo is its own shot) In this configuration, you create a shot which 
has only a logo in it. The benefit of this configuration is that you can show the logo 
independently of all other shots. For example, you can choose to always show the 
logo in a corner of your Live Broadcast display. 

2. Shot Logo (logo is part of another shot) In this configuration, you add a logo to 
an existing shot. This is useful if you want to have a shot to use in the start of your 
broadcast. 

Topics
 Global Logos

 Shot Logos

Global Logos
Logos are only displayed through shots. Wirecast treats logos the same as any other 
static media. To create a new empty shot and add your logo to it, follow these steps:

1. On Layer 2 in the Main Shot window, open the Add Shot menu.

Open Add 
Shot menu
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2. When the Add Shot menu displays, Select Add New Shot. 

3. When the New Shot displays, double-click it to edit it.

4. When the Template window displays, select Fullscreen View and click Apply.

Select Add New Shot

Double-click New Shot

Select Fullscreen View

Click Apply
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5. Click the Show Shots icon and select the logo image to display it in the Shot Preview 
window:

6. Alteratively, you can click the Add (+) button, select Add Picture from the drop-
down menu, then select the image you want to use. 

Click the Logo icon

Click Show Shots icon

Click Add button

Select Add Picture
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7. To resize the logo, make sure the logo shot source is selected, click on the logo in 
the preview window while pressing the Command key, and drag to resize the logo 
image. 

Select the logo source

Click while pressing 
Command and drag 
to resize logo
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8. To reposition the Logo, click the Position button in the Attributes Toolbar and click 
one of the positioning arrows: 

Click Position 
button

Click a 
positioning 
arrow
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The logo can also be moved, resized, and rotated using these controls:

• To Move: Click and drag object to a new location.

• To Resize (maintaining aspect ratio): Hold the Command key down while moving 
the mouse vertically.

• To Resize (independent of the aspect ratio): Hold the Command key and the 
Shift key down while moving the mouse vertically and horizontally. The Respect 
Aspect Ratio checkbox in the configuration area must be unchecked.

• To Rotate: Hold down the Option key while moving the mouse vertically and hori-
zontally.

9. To add your Logo to the broadcast, close the Shot Edit window, and click New Shot 
in Layer 2.

    

Click New Shot
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1. Click the Ripples shot in Layer 3. Notice that changing shots does not affect the 
Logo you put on Layer 2, but it does change the background image. 

Click Ripples

Logo 
remains Image changed
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Turning Layers On and Off
One way that you can use Wirecast is to turn layers on and off. For example, Layer 2 can 
be turned off and then back on by clicking its white LED on the far right side. This is an 
effective way to have a logo ready to display.

Shot Logos 
You can also create a shot with the logo embedded in it. To do this, follow these steps:

1. Double click a shot to open it in the Shot Editor.

Turn off Layer 2 LED

Logo removed

Double-click a shot
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2. Click the Add Source button to add a new source: 

3. To add your logo click the Add Shot button then click the logo icon:

4. Most likely, you will not want to display the logo in the middle of the display. To re-
position it, click the Configure Visual effects icon to display the positioning controls. 

Click Add Source 
button

Click logo icon

Click the Add 
Shot button
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The nine repositioning controls move the logo to the top, bottom, side, corner, or 
middle of the display:

You can also reposition the logo using the mouse:

• Move Media Click and drag using the mouse in the Preview area.

• Resize Media (Respect Aspect) Hold the Command key while moving the mouse 
in the Preview area.

• Resize Media Turn off Respect Aspect Ratio. Hold the Shift-Command keys while 
moving the mouse in the Preview area.

• Rotate Media Hold the Option key while moving the mouse in the Preview area. 
Select between shots in the Main window.

Click the Configure 
Visual Effects icon

Repositioning 
controls
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5. To change the size of the logo, select the logo source then hold the Command key 
while moving the mouse over the logo in the Preview area. To move the logo to the 
lower-left corner, click the lower-left arrow button.

Select logo source

Repositioning 
controls

Hold the 
Command key 
while moving the 
mouse
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Close the edit window. Notice that the River shot now has the logo embedded in it.
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Shot Editor
Introduction

      

The Shot Editor is used to view a shot, edit it, or create a new one. This section describes 
how to use the Shot Editor.

Topics
 Overview

 Shot Editor Layout

 Sources

 Shot Editor Preview

 Shot Editor Media Panel

 Shot Editor Effects

 Shot Editor Cropping

 Shot Editor Chroma Key

 Shot Editor Motion

 Shot Editor Playback

 Shot Editor Filter

STUDIO
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Overview
To edit a shot, double-click it or right-click and select Edit Shot.

The Inspector
You can also edit a shot using the Inspector. The Inspector is opened by selecting 
Inspector from the Window menu.

When the Inspector opens, if the shot you want to edit is not displayed (or no shot is 
displayed), single-click a shot in the Main window shot list to open one. The Inspector 
immediately displays the shot so you can edit it.

Activating Changes
Wirecast always displays your visual changes in the preview panel. However, your 
changes only become Live when you specifically click Go (or press the Command+G 
keys).

Note: The exception to this occurs in the Playback Panel where you can specifically 
make your changes become live.

The AutoLive feature does not apply when using the Shot Editor.

Inspector vs. Editor 
A shot can be edited in two ways: You can double-click on the shot and open an editor 
specifically for that shot, or you can open the Inspector window and then click the shot 
you want to edit. Both windows display the same set of controls. The only difference is 
that the Editor window displays a specific shot and the Inspector window displays all 
the shots that can be edited. Additionally, you can display and edit shots in both the 
Shot Editor and the Inspector at the same time.

If no shot is currently selected, Inspector buttons and other GUI elements are not 
functional. To select a shot for editing, single-click a shot in the Shot List panel at the 
bottom of the Main window.

Double-click or right-click 
and select Edit Shot
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Shot Editor Layout 
The Shot Editor is comprised of four major sections: Preview Area, Source List, 
Attributes Toolbar, and the Attributes Editor Panel.

The preview area displays a preview of how the shot looks. As you edit a shot by 
changing its attributes, visual changes are displayed in the Preview area.

The Source List is a list of sources (live sources, images, and title banners) currently in 
the shot. Wirecast enables you to put up to seven sources in each shot. You add and 
delete sources by clicking the plus (+) and minus (-) icons in the toolbar at the bottom 
of the Source List. Click a source in the list to edit it. Sources are layered in the shot, from 
top to bottom on the list. You can reorder sources using the up and down arrows in the 
toolbar below the list, or right-click the source and select Move Up or Move Down. (See 
Sources.)

The Attributes Editor Panel displays each of the configuration panels. At the top is an 
Attributes toolbar for configuring each category of attributes. To view or edit a given 
attribute category, click the appropriate icon in the Attribute Toolbar. The attributes 
change depending on the type of source (live source, graphics, audio, etc.) currently 
selected.

Preview 
Area

Source 
List

Attributes 
Editor 
Panel

Attributes 
Toolbar
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Sources 
Sources are specific resources made available to Wirecast that include configuration 
settings. These sources can be titles, live camera feeds, graphics, etc., and they are 
incorporated into shots used in a broadcast. You can place up to seven sources in a 
shot, where they are placed as layers that reside in front or in back of each other.

Templates
Wirecast also provides pre-built source sets, called templates, which you can add to 
your source list. Templates are pre-defined configurations used for displaying the 
sources of a shot. The templates contain place holders, labeled A, B, and C, that define 
where the sources in a shot are located. For example, you can select a two-source 
template that displays one element in full-screen and another, superimposed in the 
bottom left corner. When a different template is selected for the shot, the sources stay 
the same but their locations are redefined.

Templates provide an easy way to add several sources to a shot, all pre-arranged and 
organized in popular scale, angle, and position patterns (left/right, stacked, 
superimposed, etc.). Some templates have a single place-holder, some have two, and 
still others have three.

To add a set of template-based sources to your shot, click the Add Presets button to the 
right of the Sources List title. 
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Editor 
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Wirecast displays a Template window with two tabs: Templates and Virtual Sets. Click 
the Templates tab and select the template you want to use, then click Apply. 

The Preview has changed in the Shot Editor window, and now shows the Ripples image 
on the Left side. This is because the template selected has an A and a B portion to it. 
Two different sources can be assigned to A and B:

Sources in Wirecast can be assigned either A, B or C in the Source Layers list. To change 
the assignment, click the A (or B or C) icon and make a selection. This makes choosing a 
new template much simpler because Wirecast automatically positions the correct 
sources on screen.

Select Angled In

Click Apply
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For example, to change the media for the source that is identified as B, select the source 
identified as B, then click the River icon in the Configuration area. Your Preview should 
now look like this: 

Virtual Sets

In Wirecast Pro, you can also add pre-built source sets complete with graphics to 
simulate a news-anchor desk. These sets are appropriately called virtual sets which can 
be added to your source list. Virtual sets are predefined sources with graphics, available 
in various configurations. For example, you can select a two-source virtual set that 
displays three layers of decor (overhead lighting, a curved desk and a pillared 
background) with two live sources.

Virtual sets provide you with an easy way to create a professional looking scene with 
one or more live feed sources superimposed on it. These virtual sets can be used as 
they are, or they can be edited to suit your needs.

To add a virtual set to your shot, click the Add Presets button to the right of the Sources 
list title. 
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In the Template Chooser window, select the Virtual Sets tab, then click the virtual set 
you want to use. Click Apply to display it in the Shot Editor preview area.

Select a source by clicking on the name of the source in the list. 

Controlling Source Visibility
The condition of the icon to the left of each source name controls its visibility. You can 
hide or display sources in a shot by clicking its icon. When a source is hidden a red X is 
displayed over the icon.

For example, if your shot has a title, you can turn the title off by clicking once on the 
icon to display the red X. All of your title data still stays within the shot, but it is just not 
shown. To turn the title it back on, click the icon again and the red X disappears. This 
can be a powerful way to use Wirecast by pre-loading your shots with titles and then 
turn them on and off during your broadcast.

Note: The first time you select a source, its visibility is turned on (Wirecast assumes if 
you are clicking on it, you want to display it).

Shot Editor Preview 
The Preview area displays, in real time, the changes you make to the static video 
sources in your shot. However, temporal features (fade-in, audio playback, etc.) are not 

Select the Virtual 
Sets tab

Click Apply

Select a 
Virtual Set

Click a source name to select it
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portrayed in this still shot. You can also click and drag a source displayed in the Preview 
area, to reposition it.

If you add a Virtual Set, the Preview area displays a zoom slider directly below the 
preview window. This enables you to adjust all of the layers in the virtual set, to zoom in 
on the set for a a close up or pull back for a wide-angle view.

Zoom slider
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Shot Editor Media Panel 
The Shot Editor Media Panel provides a library of your shots, enabling you to easily 
assign media to a given source. You can assign three types of media to a source: Live 
Feeds, Media Files, and Title Banners. The Media Panel displays each category 
separately, making it easier to categorize and identify your media.

Live Feed Sources 
Click the Movie Camera button (camera icon) to display, manage, and select your Live 
Feed sources. Live feeds also include the devices built into your computer: microphone, 
Built-in Inputs, and any iSight camera. 

To add a live feed to a selected source, follow these steps:

1. Click the movie camera icon in the media panel.

2. Click the Plus (+) icon at the bottom of the media panel and select the system 
device you want to use for input. Wirecast adds it to the list.

3. Click the configure button (2nd button from right in the toolbar) to configure the 
device as needed.

4. Click the change media button (far left in the toolbar).

5. Click the Plus (+) icon at the bottom of the media panel, and select Show Source 
Settings to view and configure source settings.

6. In the Source Settings panel, select the device to display and change settings as 
needed.

7. Click Apply to save settings and close the Source Settings window.

In Wirecast Pro, you can add other system devices, including a Scoreboard, and Web 
streams.

Live Feeds button

Media Files button

Title Banners button

PRO
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Media File Sources 
Click the Media Files button (document icon) to display, manage, and select your file-
based media sources. Media files include: video and audio files, video-only files, audio-
only files, and raster images (TIFF, JPEG, PNG, etc.). Media files are created outside of 
Wirecast using media editing tools, then are added to the media list for easy access 
during broadcasting.

To add media files that you have created (or acquired) to a selected source, follow these 
steps:

1. Click the Media Files button (document icon) in the media panel.

2. Click the Plus (+) icon at the bottom, and navigate to and select the file you want to 
add. Wirecast adds this file to the list.

3. Configure it as needed.

Title Banner Sources 
Click the Title Banner button (T icon) to display and select a title banner source. 
Wirecast provides a comprehensive library of one to four line title banners from which 
you can choose. Title banners are graphic files with text fields that display information 
you provide. You can not add your own banner files.

To add a title banner to a selected source, follow these steps:

1. Click the Title Banner button (T icon) in the media panel toolbar.

2. Click the Plus (+) icon at the bottom of the media panel and select the title banner 
file you want to use to title this shot. Wirecast adds this title to the list.

3. Configure the title as needed by entering the text strings for each title line using 
the Text Attributes tool (4th button from left in the toolbar).
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Shot Editor Effects 
The Effects Panel enables you to adjust the location of sources and configure opacity, 
matte, aspect ratio, and scaling as needed. To open the Effects Panel, click the 
Configure button (2nd button in the toolbar). 

Clicking the position buttons (arrows) enables you to quickly change the position of 
the media in the preview display. 

You can also reposition a title using the mouse:

• To Move Media Click and drag using the mouse in the Preview area.

• Resize Respect Aspect Hold the Command key while moving the mouse in the 
Preview area.

• Resize Media Turn off Respect Aspect Ratio. Hold the Shift-Command keys while 
moving the mouse in the Preview area.

• Rotate Media Hold the Option key while moving the mouse in the Preview area. 
Select between shots in the Main window 

Configure button

Position buttons
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Opacity
The opacity control is a slider bar on the Effects Panel. Opacity controls how much you 
can see through the media. As an object becomes less opaque, it becomes more 
transparent

Note: If you want to turn off the media altogether, do not set opacity to zero since 
this still uses CPU cycles. Instead, you should turn off the visibility of the source.

Matte 
A matte is an image that is used to define the opacity of another piece of media. 
Wirecast comes with several mattes, which are listed in the Matte drop-down menu. 
Any image in your shot list which has an Alpha Channel also shows up in the Matte 
menu. (See Images/Opacity for more information on Alpha Channel.)

Opacity control

Matte menu
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Aspect Ratio 
The Respect Aspect Ratio is located under the Matte menu on the Effects Panel. When 
checked, the source retains its aspect ratio when its size is changed. Some sources do 
not allow you to set this option.

Reposition Buttons
The are three repositioning buttons on the Effects Panel: Reset Position, Scale To Fit, 
and Horizontal Flip. Click the Reset Position button to reset the media to its original 
position, size, and rotation. Click Horizontal Flip to mirror the media along the vertical 
axis. Click Scale to Fit button to scale the media to fit inside the Live Broadcast window.

Aspect Ratio control

Reset Position

Horizontal Flip

Scale To Fit
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Shot Editor Cropping 
The cropping control enables you to cut off unwanted portions of an image. To open 
the cropping control window, click the cropping control button. There are four sliders 
and four text boxes used to control cropping. Select an image, then slide the slider until 
the selected side of the image is cropped as needed. Notice that as the slider is moved, 
the value in the text box changes. This value is the number of pixels that have been 
cropped. You can also enter values directly.

Shot Editor Chroma Key
Wirecast enables you to perform real-time Chroma Key operations on your sources 
during a broadcast. Chroma keying enables you to select a color and replace all 
occurrences of that color in an image with some other image. Click the Chroma Key 
button to open the Chroma Key controls. Click the Use Chroma Key checkbox to enable 
the controls. Use the sliders to set the Key Threshold, Black Clip, and White Clip. Click 
the Defaults button to restore all controls to their default state.

Working Top Down
The key color is the color of the background you want to drop out of the resulting 
media. The Chroma Key configuration panel is designed to work through the 
configuration as a process, from top to bottom, fine tuning your key as you go. It is 
important to not over-adjust any one control. A good key color is obtained by finding 
the right balance in the controls.

Cropping control button

Cropping values

Cropping sliders

Chroma Key button

Slider controls

Defaults button

Use Chroma Key 
checkbox
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Selecting a Key Color
To get the best key possible, select the key color using the mouse. To do this check the 
Pick key color with mouse checkbox. Use the mouse to click a point on the image in the 
preview area. As you do this watch the preview change in level of transparency, 
displaying the gray/white checkerboard pattern on the affected regions. Usually, 
clicking near the corners of the media provides the best key, but sometimes clicking 
near the main subject in the image is best.

Key Threshold
Once you have the best key by picking the color, you can adjust the key threshold to 
drop out the background as completely as possible. The Key Threshold parameter 
enables Wirecast to determine how close the color in the video is to the key color. 
Adjust the key threshold (0 to 100) by using the slider.

Black Clip
Sometimes, dark areas are keyed out, when they should not be, due to how digital 
cameras function. The Black Clip parameter controls how close the keying is toward 
black. For example, if the host has black hair, you need to increase this value slightly so 
that the keying effect is not seen in his hair. Adjust the Black Clip (0 to 100) by using the 
slider.

White Clip
Likewise, white areas are also sometimes keyed out when they should not be. The 
White Clip parameter controls how close the keying is toward white. For example, if the 
host has a white shirt on, you need to increase this value slightly so that the keying 
effect is not seen in his shirt. Adjust the White Clip (0 to 100) by using the slider. 

Getting a Good Key 
Probably the most important part of getting a good key is getting good source 
material. Poor source material generates poor keys; no algorithm can make up for this.

Lighting
Assuming you have a reasonably good camera, the most important part of getting a 
good key is good lighting. Invest in good lights and learn how to set them up properly. 
Here are some basics: 

• The background screen (green or blue) needs to be independently lit from other 
items in the shot.

• Light the background screen evenly, with no shadows. The more evenly lit, the bet-
ter the keying.
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• Light people evenly with no shadows. A fill light is very important. An office white 
board may be helpful in accomplishing this.

Good Camera
You should get reasonable quality out of most cameras on the market today. Wirecast 
has been tested with a low-end DV camera to verify the quality of its Chroma Keying 
system. However, the better the camera the better the keying. 

If you use a cheap USB Web-cam, it may not give you enough source quality to get a 
reasonably good key. But if you have excellent lighting, an iSight camera works well. 
3CCD is better than 1CCD. If you have the choice, a PAL camera is better than NTSC, due 
to how data is captured internally.

High Quality Video
If you are keying video from disk and not capturing it live, make sure the High Quality 
Video option is checked in the Advanced Preferences Panel. This forces Wirecast to 
decode the video from disk in the best quality possible, giving the Chroma Key the best 
data possible for keying. Wirecast warns you if High Quality Video is turned off when 
you turn on Chroma Keying.
Wirecast User Guide | 142779



Shot Editor
Shot Editor Motion

117
Shot Editor Motion 
The Motion Panel provides control over how objects (image, movie, title, etc.) are 
added or removed in the Live Broadcast window. To open the Motion Panel, click the 
Motion Panel button in the Toolbar. Wirecast only performs motion during a Smooth 
transition. If you are using any other transition, the motion settings are ignored.

There are two types of motion. When an object is added to your broadcast it is called 
Build In; When it is removed it is called Build Out.

Motion only occurs when an object enters or leaves the Live Broadcast window. For 
example, if you have two shots, each with a foreground and the media in the 
foreground is the same, then a Smooth transition is performed between the 
foregrounds. However, no motion is performed. Or, if a logo is positioned in the top left 
corner in an existing shot, and it is in the bottom right corner in a new shot, when you 
make the new shot Live the logo smoothly transitions from the top left corner to the 
bottom right corner. But the Build In and Build Out settings are ignored.

However, if you have two shots with a Foreground, but the media in each is different, 
the Build Out is performed for the existing shot, and the Build In is performed for the 
new shot.

Direction Menus These provide selections of where the Build In comes from (top, 
bottom, right, etc.) when it is added, and where the Build Out goes when it is removed.

Fade In / Fade Out Checking these checkboxes causes an object to be added or 
removed gradually. If unchecked, the object is instantly added or removed, much like a 
cut transition.

Spin In / Spin Out Checking these checkboxes causes an object to be added or 
removed in a spinning fashion.

Scale In / Scale Out Checking these checkboxes causes an object to be added or 
removed in a scaled fashion.

Decelerate In / Accelerate Out Checking these checkboxes causes all of the above 
actions to be performed at a slower or faster rate.

Motion Panel button

Build In controls

Build Out controls

Direction menus
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Apply To All Click this button to make the Motion Settings the same for all sources in a 
shot. This is useful if you want to make all of your motion the same for all of the 
elements in the shot.

Shot Editor Playback 
The Playback Panel enables you to control how movies and music play in Wirecast. To 
open the Playback Panel, click the Playback Panel button. 

Check the Live Playback checkbox to cause your changes to be taken live in your 
broadcast. The four control buttons enable you to rewind, play, pause, or fast forward. 
In Point & Out Point sets the start and stop points in the media. 

Select a playback speed for your shot. The audio is muted for any speed other than 
normal.

Select what to do when the media is finished (loop, hold, or remove) from the drop-
down menu. Check the Begin Playing checkbox to cause the media to automatically 
start playing when it becomes live. Check the Remember Position checkbox to cause 
the media to remember its position when it is not live.

The vertical slider sets the audio level and the two meters display it in stereo (left and 
right). Click the Master Audio Mute icon to mute the audio of your broadcast. Click it 
again to un-mute it.

The Playback Panel only allows modification of parameters on media for which the 
options are possible. For example, if your media has no audio, then the audio controls 
are not active. Or, if your media is a still image, you are not able to set an In Point or Out 
Point nor play the image.

The Playback Panel setup information is saved separately for each shot, so if a media is 
used in two different shots, the media settings are different in each shot.

Playback Panel button
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Live Playback 
Live Playback is a part of the Playback settings. By default, changes in the Playback 
Panel are like any other changes in the Shot Editor, they do not take effect until you 
click the Go button. However, there are times when you may want to scrub (slowly 
scroll and view) the video and see the scrubbing in the Live Broadcast window.

Check the Live Playback checkbox to cause changes you make in the Playback Panel to 
become live. This gives you immediate control over the movie or audio in your 
broadcast.

Note: If you want to pause all movies in your broadcast, you can select Pause All 
Movies from the Media menu. This is particularly useful if you only have just one movie 
and you want to quickly pause it.

Scrubbing 
The Scrubbing slider enables you scrub (scan) back and forth through your media. The 
triangle icon in the scrubbing slider is called the playhead.

Click and drag this triangle (playhead) left and right to view any location in your media. 
The primary use of scrubbing is to set the In Point and Out Point in your media. If Live 
Playback is checked, and the shot you are editing is live, then the scrubbing is also seen 
in your broadcast.

Transport Controls
The Transport controls enable you to Rewind, Play, Pause, and Fast Forward. If Live 
Playback is checked, any changes you make using these controls are seen in your 
broadcast.

Playhead (triangle icon)

Rewind

Play

Fast Forward
Pause
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In and Out Points 
The In Point and Out Point controls are a part of the Playback settings. The In Point is 
the position in the media where playback starts. For example, if you set the In Point of a 
movie to 2 seconds, when the movie starts to play (or loops back to the start), it starts 
from the 2 second point in the movie. The Out Point is the position in the media where 
playback ends. if you set the Out Point of a movie to 5 minutes, when the movie reaches 
the 5 minute mark, it stops playing (or loop back to the beginning, depending on which 
When Finished option you have selected).

To set the In Point, move the playhead to a place you want the media to start playing 
and click the first Set button. To set the Out Point, move the playhead to the place you 
want the media to stop playing and click the second Set button. Clicking a Jump button 
moves the playhead to the In Point or Out Point location.

When Finished Control
The When Finished drop-down menu enables you to control what happens when the 
media finishes playing (when it reaches the Out Point).

You have three options: 

• Loop The media loops back to the In Point.

• Hold The media stops and displays the last frame.

• Remove The media is removed from Live Broadcast Area. The remove function 
makes the media transparent after it is done playing. For example, if you are doing 
a live show with an intro video layered over your camera feed, when the intro video 
is finished it becomes transparent, leaving only the camera feed displayed.

Note: For media without video, the Hold and Remove are effectively the same option.

Begin Playing Control
When checked, the Begin Playing checkbox causes the media to start playing when the 
shot becomes Live. Checked is the default.

In point and Out Point times

Set buttons

Jump buttons
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Remember Position Control
If the Remember Position checkbox is checked, when a live shot transitions to another 
shot with different media, the removed shot remembers the last position where the 
media was played. And so, if the removed shot becomes live again it starts playing from 
that remembered position. Checked is the default.

Audio Controls
If a piece of media contains audio, the audio controls become activated. The audio in 
each media is independently controlled. The audio slider bar enables you to control the 
media audio level. Clicking the speaker icon mutes the audio of your media in the Live 
Broadcast. Clicking it again causes it to be heard. The stereo audio meters monitor the 
audio output level.

Shot Editor Filter
The Filter Panel is available when you are editing a shot and you have selected one of 
the following sources: Title, Foreground, Scene, or Background. 

Note: Filters are only available for Macintosh OS X 10.4 (Tiger) or greater.

Audio meters

Audio slider

Speaker icon
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To add a filter, click the plus (+) button at the bottom of the Shot Edit window and 
select a filter from the drop-down menu. In the example below, the Color Controls filter 
has been added to change the colors in the shot.

Modifying the Filter Parameters
A filter can have a large number of parameters. Therefore, it is beyond the scope of this 
user guide to describe all of the possible options a particular filter may provide. 
However, the parameters should be straightforward to configure, using the controls 
provided.

Here is an example of changing the contrast on the River image:

Color Controls filter 
selected

Color controls

Filter button
Wirecast User Guide | 142779



123
Source Settings
Introduction
These topics describe how to use the Source Settings editor.

Topics
 Overview

 System Devices

 Scoreboards

 Teradek Cube

 Remote Desktop Presenter

 Local Desktop Presenter

 Web Stream

 Capture Cards

 Show USB Devices

Overview
To open the Source Settings window, select Sources > Show Source Settings. 

Note: Since some of the Source Menu items are plug-ins, the order of the items will 
not always be the same.

The Source Settings window is divided into four sections: System Devices, Preview 
Window, Configuration Area, and Button Bar:

• The System Devices displays all the devices detected by Wirecast (USB and FireWire 
devices, microphones, line inputs, Webcams, etc.). Sources used are selected from 
this list.

• The Preview Window provides a preview of the video coming from a selected 
source. 
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• The Configuration Area is for configuring sources. When a source is selected from 
the System Devices list, the configuration options for that source are displayed.

• The Button Bar contains two buttons. Click the plus (+) button to manually add new 
sources. Click the minus (-) button to remove them.

Note: In Wirecast versions 4.0 and above, de-interlacing has been moved from 
System Preferences (where it was a global setting) to the Source Settings, where it is 
individually controlled by each device.

System Devices
System devices include Firewire devices, USB cameras, and other USB devices. Click on 
a device to select it. Two drop-down menus and a configuration button are displayed. 
The Capture Device Size menu selects the device resolution from 160x120 to 1920x1080, 
depending on the camera. The Device Deinterlacing menu selects either None or 
Blend. None turns off deinterlacing enabling the video to interlace normally. Blend 

System 
Devices

Configuration 
Area

Preview 
Window

Button Bar
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turns deinterlacing on enabling the video to avoid interlacing problems during motion. 
Click Configure to configure the selected device.

When you click Configure, a properties window displays with two tabs. The Video Proc 
Amp tab enables you to set the video display properties. The Camera Control tab 
enables you to set camera image properties. Any properties that do not apply to the 
selected camera are greyed-out. 

Scoreboards

Scoreboards allow you to add a scoreboard graphic to your broadcast that can be 
dynamically updated. To add a new scoreboard, select New Scoreboard from the 
Sources menu. Multiple scoreboards can be added. 

Select a 
device

Select 
resolution

Click to 
configure 
device
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When a scoreboard is opened in the Source Settings editor, it displays a preview of the 
scoreboard, two drop-down menus, and two configuration tabs.

Unlike most other elements in Wirecast, changes to the Scoreboard go live instantly 
without requiring a transition. Once the scoreboard is live, the preview image is exactly 
as it is seen in your broadcast.

Of the two drop-down menus, the first selects the style of the scoreboard (Pipe, Shade, 
Corner, Wide, etc.) and the second selects the scoreboard layout (Basic, Top, Bottom, 
etc.). Some layouts change the number of fields surrounding the scoreboard, allowing 
additional live information to be added.

There are four hotkeys associated with the Scoreboard.

In order for these hotkeys to be active, the scoreboard must be displayed in the Live 
window and the Wirecast main window must be in focus (selected as the active 
Windows window).

= Increments Home score

- Decrements Home score

] Increments Visitor score

[ Decrements Visitor score

Preview

Drop-down 
menus

Configuration 
tabs 
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The Data Tab
The Data tab configures the information displayed inside your scoreboard. The first two 
lines of data hold the name and score of each team. Before broadcasting, you should 
enter the names of each team here. While the broadcast is live, click the “+1”, “+2” and 
“+3” buttons to modify the score.

There are also four information fields (Field 1 through 4). Each field controls a line of 
text inside the scoreboard that can be seen using the various layout types.

Note: Because Wirecast updates the scoreboards dynamically, It is recommended 
that you fill in the additional information fields while using a layout that hides them. 
Then, change to a layout that reveals those fields when ready, otherwise your viewers 
see you typing in those fields live.

The Look Tab
The Look tab controls the visual elements of your scoreboard. In the Name Options 
column, there are three buttons for each field. These buttons enable you to change the 
text alignment, font style and text color respectively. The Score Options (on the right 
side) provide the same three adjustments to the score.

Information 
field displays

Style menu

Data tab 

Layout menu

Teams names

Score controls

Information 
fields
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Some scoreboard styles also allow you to change the background colors of the Home 
and Visitor fields, to make them match their team color. This option, when displayed, is 
located between Name Options and Score Options.

You can also choose a custom image as the background of your Scoreboard.  To do this 
check Use Custom Image.  When you do, the Choose button is enabled.  Click Choose 
and navigate to your custom background and select it.

Look tab 

Name Options

Text alignment

Font style

Text color
Ckeck Use a Custom Image
Click Choose
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Teradek Cube
You can download the Teradek plugin from:  http://www.teradek.com/pages/
downloads. On the download page, select StreamReader Plugin for Wirecast.

                    

Remote Desktop Presenter
The Remote Desktop Presenter (RDTP) is a utility application that enables Wirecast to 
broadcast the desktop of any computer running the Telestream Desktop Presenter 
program.

Desktop Presenter is normally auto-detected by Wirecast and is automatically added to 
the list of sources. However, if a RDTP is not detected, or if you want to add one in a 
remote location you can manually add it by selecting New Remote Desktop Presenter 
from the Source menu in the Main window. 

STUDIO
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You can then setup the presenter in the Source Settings window by entering an IP 
address of the target computer, optionally checking the With Audio checkbox, and 
clicking Apply:

Note: When a Desktop Presenter has been auto-detected, the IP Address field is 
disabled.

For more information, refer to the Telestream Desktop Presenter User Guide.

Local Desktop Presenter
The Local Desktop Presenter (LDTP) is a utility application that enables Wirecast to 
broadcast the desktop of your computer running Wirecast. It enables you to capture 
from a local source at high resolution and at a high frame rate. It can be used to capture 
video sources. Add a LDTP by selecting New Local Desktop Presenter from the Source 
menu in the Main window. 

Select Presenter

Enter IP Address

Check With Audio 
(optionally)

Click Apply

Desktop Display
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Setup the presenter in the Source Settings window by selecting a Capture Type: 
Monitor or Window. Monitor captures the whole display from a specified monitor. 
Window captures any selected window. 

Click Select Window/Monitor (above) to define what monitor or window to capture. If 
you selected Monitor for the Capture Type (above), you can choose which monitor to 
capture, if you have multiple displays.

If you selected Window for the Capture Type, a selection window opens. Select an 
Application, then select a Window (only windows associated with the selected 
application are listed) to identify which window is captured. 

Select Local Desktop 
Presenter

Select Capture Type

Click Save Settings

Desktop Display

Select window or 
monitor

Click OK

Select monitor

Click OK

Select Window

Select Application
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Other Local Desktop Presenter controls are:

Show Cursor When checked, causes the cursor to be captured in addition to the video 
source.

Capture Audio When checked, captures audio in addition to video. Click Audio 
Settings to select the audio source.

FPS Select the frame rate at which you want the video to be captured.

Disable Capture When checked, capture is disabled.

Audio Settings Enables you to select an audio source to be captured with the video.

Sources are automatically deteced and displayed in the Web Stream list. They are also 
identified as ONVIF or Bonjour detection. Select also an ONVIF Profile. Set controls as 
needed, then click Connect when finished.

Select a Web 
Stream source

Click 
Connect

Set 
Controls

Set ONVIF 
Profile

Detection identifiers
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Web Stream

The Web Stream option allows RTMP, RTSP, MMS, or HTTP streams to be taken directly 
into Wirecast. This is useful for incorporating remote IP Cameras or other network 
streams into a broadcast.

Select a Web Stream source. Sources are automatically deteced and displayed in the 
Web Stream list. They are also identified as ONVIF or Bonjour detection. Select also an 
ONVIF Profile. Set controls as needed, then click Connect when finished.

The Web Stream controls are:

Protocol Select the protocol to use with your incoming stream.

Stream Options Select a set of options based on the protocol you selected (the sub-
protocol of the stream). RTSP can be transmitted over UDP, TCP, or HTTP. RTMP can be 
transmitted non-encrypted, over http, encrypted. If unsure what to use, select Auto 
Detect.

PRO

Select a Web 
Stream source

Click 
Connect

Set 
Controls

Set ONVIF 
Profile

Detection identifiers
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Format Options Select a video format to use for transcoding. If you select Auto Detect 
(the default) Wirecast with automatically detect the format to use from the incoming 
stream.

Ignore Stream Timestamp When checked, stream timestamps are ignored. Every 
Audio/Video frame has a Presentation timestamp, a time that tells the player when to 
show the frame. Checking this box causes the Web Stream to ignore the presentation 
timestamp set by the video stream and just use the current system clock.

Live Stream When checked, specifies that the stream is a live stream and video on 
demand. For Wowza servers, it does not do anything, but for Adobe Media Servers, Live 
Stream must be checked for live streams.

URI Enter the address of your input stream. (For example:  rtsp://127.0.0.1:8080/
my_stream.sdp, or http://10.0.0.1/my_stream, or rtmp://hades.telestream.net:1935/live/
myStream).

ONVIF Authentication Click to connect to remote devices, like IP cameras, which 
require login credentials for access. Check the Remember checkbox to save your 
credentials to cause the device to automatically connect.

Save Settings Click to save your Web Service control settings.

Capture Cards 

                     

Capture Cards are hardware extensions that enable you to bring in video from more 
advanced HDMI and SDI sources. Most capture cards are automatically configured to 
the best settings. Some cards (Blackmagic Intensity Pro, for example) require some 
manual adjustments. When a Capture Card is selected, you can select the Frame 
Format. Clicking Save causes the video to display. You can also check the De-interlacing 
checkbox to turn on de-interlacing. Once configured, you can add Capture Cards from 
the Live Source drop-down menu in the Main window. 

Click OK

Enter Logon info

Check Remember

STUDIO
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If you experience difficulty with your Capture Card, make sure you have the latest driver 
from the vendor and that it is installed correctly before contacting Customer Support.

Capture cards supported by Wirecast:

• Blackmagic Intensity Pro

• Blackmagic Intensity Shuttle

• Blackmagic Decklink Studio

• Blackmagic Decklink SDI

• Blackmagic Decklink Duo

• Blackmagic Decklink Extreme 3D

• Osprey 240e, 450e, 700e

• Matrox Multi

Blackmagic

You can use Blackmagic cards to send live feeds directly into editing, effects, and 
broadcast design systems. In order to use this feature, install a Blackmagic card with 

Frame Format

De-interlacing

Click Save

PRO
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associated drivers, then restart Wirecast. The Blackmagic card will then be listed in the 
Output menu.

Under the Output menu, select a Blackmagic card, and then select an HD setting for its 
output. If your card has multiple outputs, you can select more than one and they will 
output simultaneously at independent resolutions and frame rates.

     

To begin outputting, select Start Output. If you have multiple outputs selected they will 
all begin outputting.

     

Select an 
HD setting

Select Start 
Output
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You can stop the Blackmagic card output by selecting Stop Output. If you have multiple 
outputs selected they will all stop outputting.

    

Show USB Devices 
To view a list of all USB devices select Show USB Devices from the Sources menu. The list 
displays all connected USB devices, the USB bus on which each USB device is located, 
and the speed of the device. This information is helpful when troubleshooting USB bus 
bandwidth issues. Click Show All Devices to display all available USB devices, otherwise 
only video devices are listed. Click Refresh to update the list. 

•

Select Stop 
Output
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Playlist
Introduction
Playlist enables you to create a list of clips and play them as a single group. You can 
have multiple playlists and edit them as needed after they are created.  You can also 
replay playlists (see Replay). This makes the combination of Playlist and Replay a very 
powerful production tool.

Topics
 Creating a Playlist

 Adding Clips

 Playing Playlists

 Playlist Controls

 Restoring Playlist Position

 Countdown Clock Options
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Creating a Playlist
To create a new Playlist, select New Playlist Shot from the Shot Menu and a new Playlist 
shot icon is added in the shot window.

The Playlist shot icon displays a playlist badge, the playlist duration, and the playlist 
completion action.

Click the Shot 
Menu

Select New 
Playlist Shot

New Playlist 
shot

Playlist badge

Playlist badge

Playlist completion action
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Adding Clips
To add clips to the playlist, first click and drag them onto the layer where the new 
Playlist is located.

Second, click and drag each shot onto the playlist icon. When you do this you must wait 
for the playlist icon to obtain a yellow border before releasing the click button.

Added clips

Click and drag clip

Release when yellow boarder appears
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Double-click the Playlist icon to open the Playlist window. You can drag and drop more 
clip directly into the Playlist window when it is open. You can also add clips by selecting 
Add New Shot from the Shot Menu.

These added shots are now housed in the Playlist. You can still edit shots in the playlist 
by double-clicking on the shot. You also have all of the Change Shot menu options 
available by right-clicking on the shot.

Note: Do not delete shots from a playlist while the playlist is live.

The Change Shot menu for Playlist shots has one additional option: Modify Duration. 
You can set the shot duration to any value by selecting Modify Duration and entering a 
new duration when the dialog box displays. Click OK when finished.

You can, optionally, reset the duration to its original value by clicking Reset.

Add clip by click and drag
Add clip by selecting Add New Shot

Double-click 
shot to edit it

Right-click shot to access 
the Change Shot menu

Click Reset 
(optionally)

Enter shot 
duration

Click OK
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You can also add live sources to the playlist. To do this click the Live Sources menu and 
select a live source from the list.

By default, live sources have an infinite duration (since they are not a clip). So, you must 
assign a duration by selecting Modify Duration for the live source and entering a 
duration when the dialog box displays. Click OK when finished.

Note: Wirecast does not support nested playlists (playlists withing playlists).

Select a live sourceClick Live Source menu

Enter shot 
duration

Click OK
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Playing Playlists
Playing back a playlist is the same as playing any other shot -- click the playlist shot to 
place it into preview, then click the Go button to take it live.

Playlist Controls
Playlist provides some basic playback controls. You can transition to the previous or 
next shot in the list, set playlist behavior, transition between shots, and choose the 
currently live shot.

Click Playlist icon Click the Go button Playlist runs in live window

Make selected 
shot live

Transition to previous shot

Transition 
between shots

Transition to next shot
Set Playlist behavior
Wirecast User Guide | 142779



Playlist
Playlist Controls

145
Transition to previous shot Transitions to the previous shot in the playlist if the 
playlist is currently live.

Transition to next shot Transitions to the previous shot in the playlist if the playlist is 
currently live.

Set Playlist behavior Sets the behavior of the playlist when the last shot in the list has 
been played. A check mark indicates what menu item (behavior) is selected.

• Loop transitions back to the first shot, endlessly.

• Hold stays on the last shot. If the last shot is a clip, the last frame in the clip is dis-
played. If the last shot is a live shot, the live source stays active.

• Available Shots transitions to another shot on the same layer. All available shots are 
listed as menu selections. (In the example shown, the only available shot is “Logo”.)

• Previous Live Shot transitions back to the shot that was live before the playlist began 
playing.

• Current Preview transitions the contents of Preview to the live window.

Transition between shots Sets the transition to use between shots in the list.

Make selected shot live Takes the currently selected shot in the playlist live, if the 
playlist is live.
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Restoring Playlist Position
Checking the Restore Previous Active Shot check box causes the playlist to remember 
which shot was playing (and its position) when the playlist is taken live.

Without checking the Restore Previous Active Shot, the playlist always starts from the 
first shot.

Countdown Clock Options
Select New Playlist -- Completion from the gear menu (displayed only when playlist is 
playing) to display the countdown clock for both the current shot playing in the playlist 
as well as the countdown for the playlist itself. When New Playlist -- Completion is not 
selected (not checked) only the current shot countdown clock is displayed.

Check Restore Previous Active Shot

Countdown clock for current shot

Select New 
 Playlist -- Completion

Click the gear icon

Countdown clock for playlist
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Add a live source to your playlist by selecting a live source from the Shot Source menu. 

When a live source is in a playlist, a New Playlist -- Live option is added to the playlist 
gear menu. When you select this option, the countdown clock displays the time 
remaining until the next live source in the playlist begins to play.

The countdown time until the next live shot is the sum of the durations of all the shots 
preceding it. When the live shot begins, the countdown clock displays the countdown 
of that live shot. If the live shot does not have a duration, then the playlist is halted and 
the live shot remains until another shot is taken live or the playlist is replayed.

Click the Shot Source menu Select a live source

Select New 
 Playlist -- Live

Click the 
gear icon

Time remaining until next live shot
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Social Media
Introduction
Social Media enables you to add social media messages to you broadcast and you can 
filter what messages are displayed. The only social media available in Wirecast is 
Twitter.

Topics
 Settings

 Message Feed

 Create Shot

Settings
The first thing you need to do is log on to Twitter.  To do this click Social > Settings, 
select Feed Type, enter your login information, and click OK.

Enter login info

Click OK

Select Feed Type
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Message Feed
Click Social > Message Feed to add some Twitter messages to your broadcast.  When the 
message window displays, search (optionally) for the messages you want to broadcast.

To select messages to be rotated in your broadcast, first check Rotate Selected Every, and 
enter the number of seconds of the rotation interval. Select the messages you want 
rotated by checking the box at the left of each message. Select a starting message.

Enter search word

Check Rotate Selected Every

Enter rotation interval

Select messages

Select starting message
optionally check Auto 
Refresh and enter 
number of seconds
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You can also (optionally) check Auto Refresh and enter number of seconds. The gear 
icon allows you to select or unselect all messages.  Once you have selected your 
messages, close the Message Feed window.

Create Shot
To create a new Social Media shot, select Social > Create Shot.  When the new shot icon 
is displayed, click it to place it in the Preview window.  Then click the Go button to take 
it live.

Click Social Media Shot Click the Go button
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Replay
Introduction
 

Replay enables you to repeatedly play a clip, or even a portion of a clip, any number of 
times or endlessly. You can also replay playlists (see Playlist). This makes the 
combination of Playlist and Replay a very powerful production tool.

Note: Multiple Replay clips captured during the same replay session will not render 
correctly when played at the same time on different master layers or different shot 
layers.

Topics
 Replay Settings

 Replay Activation

 Replay Templates

PRO
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Replay Settings
To use Replay you need to set it up the way you want it to perform. To do this select 
Replay > Settings. Make your desired settings and click OK when finished.

Video Quality Set the video quality for Standard or High. Depending on what quality 
you choose, an estimate of the write rate will be displayed.

Audio Check the Audio box to capture audio in the Replay you are creating. If 
unchecked all audio is ignored.

Maximum Duration Sets the maximum duration of the Replay buffer. Unlimited allows 
you to go all the way back to the beginning of your broadcast (no matter how long), 
which will require a lot of disk space, or you can select Limited to which allows you to 
choose how many minutes back into your broadcast is buffered. This option uses less 
disk space. Depending on how many minutes you choose, an estimate of the disk 
storage required will be displayed.

Note: If you set maximum Duration to Unlimited Replay will use disk space until all 
available is used.

Replay Folder Click Browse and navigate to the location where you want to store your 
Replay shots.

Default Replay Duration Specifies the default duration of a Replay clip (sets In and 
Out points) when you click Create Replay Shot. For example, when the duration is set to 
30 seconds (the default value) it means that the In point will be set 30 seconds before 
the Replay shot was created.
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Create Replays In Allows  replays to be created in master layers or playlists. You can still 
move the shots to other layers at any time after they are created.

After Creating Replay Shot When checked, the Replay shot is displayed in the Preview 
window. This allows you to set the In and Out points for the Replay shot rather than 
having to open the shot editor to set them.

Activate Replay On You can choose to start the buffering of Replay (activate the 
Replay system) manually, when you start recording, or when you start broadcasting. 
The problem with Manually is that you may forget to turn on the buffering. So Record 
and Broadcast options are provided to allow this to be automatic.

When Deleting Replay Shot When deleting a shot, you can choose to have Wirecast 
ask (prompt) you if you want to keep recording, or just to keep recording without 
asking you, or to just delete the recording.

Replay Shot Template Allows you to select an existing Replay shot to act as a template 
for other Replay shots, or no template at all (by choosing None). For more information 
see Replay Templates.

Use As Defaults Click this button to make all the settings you have made to be the 
default used in all created Replay shots.

Replay Activation
To activate Replay, select Replay > Activate. When you do this, the Activate menu item 
becomes Deactivate and several new buttons are added to the Wirecast main window: 
Set Replay Endpoint and Create Replay Shot (same as selecting Replay > Create Replay 
Shot).

Once Replay has been activated it keeps all shot activity (playing of clips or capturing of 
live sources) in the Replay buffer on disk. The amount that is saved when the Create 
Replay Shot button is pressed depends on what value was entered into the Default 
Replay duration setting.

Start playing a clip (while Replay is activated), then click the Create Replay Shot button. 
Since the Default Replay Duration is set at 30 seconds, a Replay shot of 30 seconds 
(backward from when the Create Replays Shot button was pressed) is created. The new 

Set Replay Endpoint button

Create Replay Shot button
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Replay Shot is placed in Layer 1 (as designated in the settings) as an icon and the Replay 
controls are displayed at the bottom of the Preview window.

Replay controls displayed

Select a clip to play

Click Go to play clip

Click Create Replay Shot

Replay Shot created
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Now that you have a 30-second Replay Shot displayed in the Preview window, you can 
use the controls to set the Replay In and Out points and then take the Replay Shot live 
by clicking the Go button.

The Endpoint button allows you to tighten up your Replay capture. When Replay is 
active, it captures all past activity of your source (clip or live source) into the buffer. But 
you can shorten how much of the capture you actually get in a Replay shot by clicking 
the Endpoint button first (to establish when to start your Replay Shot, and then click 
the Create Replay Shot button when you are finished with your Replay shot. Your Replay 
Shot now has just the content you wanted.

Another control available at the bottom of the Preview window is the Magnification 
control. Click the magnifier icon (spyglass) to display a magnification slider. Slide the 

Click Go buttonSet In Point Set Out Point

Click Replay Endpoint button

Click Create Replay Shot button
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slider to the left for lower magnification of the In and Out controls, and to the right for 
greater magnification.

For example, if you move the slider to the right, the In and Out controls move farther 
apart, increasing the magnification, so that you can more easily adjust the location of 
the In and Out controls. This is very helpful when you have long duration Replay shots. 
However, the slider will quit sliding when you have reached the maximum size of the 
Replay Shot. 

One more control is available at the bottom of the Preview window. It is the Replay the 
speed control. You can set the speed of the Replay Shot by clicking the speed icon 
(“1x”) and selecting a speed from the pull-down menu. Your choices are 1x (normal 
speed), 2x (double speed), .5x (half speed, and .25x (one-fourth speed). The audio is 
muted for any speed other than normal.

Replay Templates
Replay templates allow you to create a template shot to use as a pattern for how you 
want your Replay Shots to look and act. 

In and Out point 
controls

Magnifier slider

Magnifier icon

In and Out point 
controls moved

Magnifier slider 
moved right

Click the speed icon

Select a speed
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Create a new shot, then double-click that shot to open it in the shot editor. When the 
Template Chooser displays, select the Fullscreen View template and click Apply.

When the Shot Editor opens, add another layer by clicking the Add (plus) button in the 
lower left corner. Open the Clip Sources menu and select an image for the new layer. 
Close the Shot Editor when finished.

Select Fullscreen View

Click Apply

Click to open

Click to add 
new layer

Select an image
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Right-click the new shot and select Rename Shot. When the Rename Shot window 
opens, rename the shot Replay Template. Click OK when finished.

Open Replay Settings (Replay > Replay Settings) and select Replay Template from the 
Replay Shot Templates menu. Click OK when finished.

Right-click and select 
Rename Shot

Click OK

Rename Shot

Select Replay Template

Click OK
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There is also a Replay Channel menu. From here you select which channel (layer) in the 
template shot to use in the Replay Sot. You can only choose one channel (A, B, or C). 
This channel (layer) is replaced by the video playing when the Replay shot is created. 
Any other channels (layers) that exist in the template shot are used exactly as they are 
(content, size, and position) in the Replay shot.

You are now ready to create a Replay Shot using the Replay Shot template. To do this, 
activate Replay by selecting Replay > Activate. Start playing a video in the live window, 
then click the Create Replay Shot button. This will create a new Replay shot that used 
the template to add the logo image on another layer. The new shot has an icon in the 
shot area and is opened in the Preview window ready for you to set In and Out points 
and to take live by clicking the Go button.

Select a Channel

New Replay Shot in 
Preview window New Replay Shot icon
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Audio Inspector
Introduction

   

The Audio Inspector enables you to monitor and control all of the audio sources from a 
single control panel. This section describes in detail how to use the Audio inspector.

Topics
 Overview

 Hardware Audio

 Shot Audio

Overview
To open the Audio Inspector panel, select Audio Inspector from the window menu.

Note: The use of the Audio Inspector requires a Wirecast Pro license. For licensing 
information, select Preferences from the Wirecast menu, click the Add (+) button, then 
click Purchase. Or, contact sales@telestream.net.

The Audio Inspector separates your audio by hardware and shot. Live Input is always 
the first section to the right of the Master control, and it contains all hardware audio 
sources you may be using. This includes microphones, audio input feeds, cameras, 

PRO

PRO
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capture cards, Web streams, etc. The remaining audio controls are associated with 
specific shots. 

Hardware Audio and Shot Audio
The Master control sets and displays the total audio output of your broadcast. Click the 
headphones icon (directly below the Master controls) to mute the local audio feed. 
(This has no effect on the broadcast audio output.) The Mute button, below the 
headphones icon, mutes all local audio and all broadcast audio.

Below the name of each audio source is a white label box. You can rename this box to 
describe your source. To rename the audio source, click in the white box and enter the 
new name.

Hardware audio sources are automatically added to the Audio Inspector whenever a 
new audio source is added through the Main window or through the Shot Editor. You 
can also manually add a hardware audio source by clicking the Live Input drop-down 
menu at the top of the Live Input section.

Master Audio control panel

Master Audio level control 

Master Audio level display

Headphone Mute icon

Master Mute button

Live Input control
Shot control

Label box

Live Input 
drop-down 
menu
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Hardware Audio
Hardware audio sources are hardware devices and live sources. This includes dedicated 
microphones, cameras (that have audio), audio line feeds, capture cards, etc.

When you add a device to the Audio Inspector as a Live Input, it defaults to the lowest 
volume level, because all Live Input audio sources act as global audio sources through 
the Audio Inspector. Thus, any source listed in the Live Inputs section can be 
immediately added to a broadcast by dragging the volume slider on that source up.

The horizontal slider in a Live Input controls the audio delay. Dragging the slider to the 
right increases delay, up to one second, to fine-tune audio in sources where the audio is 
ahead of the video.

Note: Audio that is out of sync with video is common when running a microphone 
directly into your computer's audio input when using a FireWire camera as a video 
source. Most FireWire devices create a latency that causes the audio to be ahead of the 
video.

Shot Audio
Shot audio sources come from shots that are currently live in your Wirecast document. 
Any time a shot becomes live, it immediately displays in your Audio Inspector.

Adding Shot Audio Sources
The Shot Audio panels are always displayed to the right of the Live Input panel in the 
Audio Inspector. Shot audio is automatically added to your broadcast whenever a shot 
containing audio transitions to live broadcast. 

New Shot Audio controls are created as multiple shots are made live during the 
broadcast. For example, if you have live shots with audio sources in Master Layer 1, 2 
and 3, Wirecast displays three Shot Audio panels. Each panel enables you to control the 
audio output of the source it controls.

Audio Delay control
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Managing Audio Sources
Shot audio is most useful in controlling the audio levels during a live broadcast. You can 
use the sliding meters to adjust the volume levels of any source during broadcast. If a 
source begins contributing audio that is wrong or distorted, you can click the Mute 
button at any time to silence it. Its muted state is maintained even if you change shots 
and come back to it.
Wirecast User Guide | 142779



167
Preferences
Introduction
Wirecast is designed so that you can configure most of your options directly in your 
Wirecast document or the Shot Editor. The Preferences window enables you to set up 
Wirecast, set Desktop Presenter options, manage your licenses, update your software, 
and set advanced video options.

Topics
 Accessing Preferences

 General

 Performance

 LicensesSoftware Update

 Advanced

Accessing Preferences
To open the Preferences window, select Preferences from the Wirecast menu (or press 
the Command+ Comma (“,”) keys). Preferences are grouped under five topics: General, 
Performance, Licenses, Software Update, and Advanced. Click one of these topics to 
view and change its preferences.
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Wirecast automatically saves your preferences every time you make a change. The 
changes are immediately applied.

Resetting Preferences
To reset your preferences, quit Wirecast and then delete the files located at:

~/Library/Preferences/Vara Software/Wirecast Preferences.

•

Or, you can use Support Assistant to reset preferences (see Send Support Information 
under Help Menu).

Note: You should match the output to the canvas size as close as possible to preserve 
video resolution and quality. For example, a 800x600 source results in significant loss 
of quality if an aspect ratio of 640x480 is selected. Using 720x576, which is much 
closer in size, helps preserve video quality. 

General
General preferences enable you to setup the Wirecast environment.

Open Last Document on Startup 
When checked, the last document you used is opened when Wirecast starts up. 

Shot Editor Checkerboard
When checked, a checkerboard background displays in the Shot Editor to indicate an 
area that is transparent. Checked is the default.
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Feedback Detection
When checked, the computer audio is disabled (live feed is unaffected) whenever 
feedback is detected. Checked is the default. When feedback is detected, the following 
warning is displayed with an option to turn off feedback detection:

Maximum Reconnection Attempts
Enter the number of times you want Wirecast to try to reconnect to a host provider. The 
default is three.

Performance 
Performance preferences enable you to select the display rate used for all internal video 
rendering. 

You can set the Video Display Rate to 25, 30, 50 or 60 fps. If using PAL sources, choosing 
25 may eliminate dropped or duplicate frames.  It is recommended that you set this 
frame rate to match the frame rate of your output video encoder. 

You can turn on the Live Icons feature, which makes all icons in the Shot Area display 
any live activity in the device it represent (cameras, streaming, etc.). You can also set the 
FPS of the Live Icon display using the slide bar control.
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Note: If you are streaming at 60 fps for games, you need to set the video display rate 
at 60 fps here in Preferences and at 60 fps also in your encoder preset. 

Licenses
Licenses preferences enable you to register and license Wirecast. To purchase a license, 
click Purchase.  To activate a license, click the plus (+) button.

Serial Numbers
The table in the Buy Upgrade Preference window displays the products and serial 
numbers that you have received for Wirecast.

Note: The serial number is always composed of numbers and upper case letters 
(excluding upper case letter O), but it never contains quotation marks. When you 
receive a serial number, it may be enclosed in quotation marks (e.g., “123-456-789”). 

To add a valid serial number, press the plus (+) button. If you wish to purchase a serial 
number from the web store, click Purchase. When Wirecast displays the Enter Serial 
Number window, enter the serial number and click OK. Wirecast validates the serial 
number and unlocks Wirecast. If you previously purchased a copy of Wirecast and want 
to use that serial number, enter that serial number to unlock Wirecast.

Note: If you do not want to purchase a serial number directly in Wirecast, you can also 
purchase a serial number at www.telestream.net, or you can purchase a serial number 
from Telestream by phone at: 530.470.1300.

Click Purchase

Click to activate
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Manual Activation
If your computer is not on the Internet, you can use another computer to activate your 
license and unlock Wirecast. To manually activate your license, download the Manual 
Activation Guide at: www.telestream.net/telestream-support/wire-cast/support.htm 
and follow the steps in the guide to unlock Wirecast.

Deactivate Serial Numbers
Deactivating a serial number allows you to re-activate it on another computer. You can 
always reactivate a serial number by re-entering it. To deactivate a serial number, select 
an activated product serial number, and click dash icon (-). Wirecast deactivates the 
serial number and adds water-marking to the video and audio whenever licensed 
features are used. When you deactivate a serial number, it is removed from the table.

Demonstration Mode
When no serial number is entered or activated, Wirecast water-marks all output (both 
to disk and network). The video water-mark is a periodic overlay of the Wirecast logo. 
Audio water-mark is a periodic voice over. If you have a Wirecast serial number and are 
using a Wirecast Pro feature without a Pro license, that output is also water-marked.

Click Deactivate License

Click to deactivate
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Software Update 
Software update preferences enable you to obtain Wirecast updates.

Automatically Check Updates
Check the Automatically Check For Updates checkbox to cause Wirecast to check for 
updates on the Telesteam Web site each time Wirecast is launched. No personal 
information is transferred to Telesteam during this action.

Check Now
Click Check Now to immediately check for updates on the Telesteam Web site 
(www.telestream.net). No personal information is transferred to Telesteam during this 
action.

Advanced 
Advanced preferences enable you adjust advanced settings for Wirecast.

       

Note: Capture Device Size has been moved to the Source Settings window.
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Use High Quality Video
Check the Use High Quality Video checkbox to increase the quality of decoding 
performed on your source media files. If CPU usage is near 95%, or if the frames per 
second (FPS) is consistently well below your target, uncheck Use High Quality Video to 
remedy this. Checked is the default.

YUV Colorspace
If Render using YUV colorspace is checked, video frames will be rendered on the GPU 
using YUV rather than RGB. This will typically provide a performance advantage and 
save on memory.  Performance will improve when streaming to most destinations 
(including Virtual Camera Out). The best way to know if this option is advantageous to 
use on your system is by trial and error, and observe the results. 

Disable ONVIF IP Camera Discovery
Check Disable ONVIF IP Camera Discovery to turn off automatic discovery of ONVIF IP 
Cameras.

Disable Bonjour IP Camera Discovery
Check Disable Bonjour IP Camera Discovery to turn off automatic discovery of sources 
using Bonjour.
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Asset Manager
Introduction
The Asset Manager is used to change the sources of media in your document.

Topics
 Documents

 Re-assigning Media

Documents
Wirecast stores a path to your media in the Wirecast document. If you relocate your 
media, Wirecast no longer is able to find them. In this case, use the Asset Manager to 
reassign the new media locations. However, Wirecast does keep track of the relative 
path to your media. If you move both the document and media to a new position, 
Wirecast still finds the media. 

Re-assigning Media
To reassign media, follow these steps:

1. To open the Asset Manager, select Show Asset Manager from the Wirecast Media 
menu.

2. Select the media you want to assign to another source.

3. Some media assets (i.e cameras) enable you to set the aspect ratio by displaying a 
Device Aspect Ratio menu. You can select an aspect ratio from this menu.

4. Select the new media from the Assign To menu, or click Browse and locate the 
replacement media on disk.

Note: When Desktop Presenter is selected as the source, you can enter the IP address 
for the Desktop Presenter. This enables you to build a Wirecast presentation with 
place-holders and then reconfigure at a later date to accommodate a new presenter 
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with a new Desktop Presenter as a source. Additionally, if you select a camera input 
source from the Media List, an additional menu to set the Device Aspect Ratio of the 
camera is displayed. This is useful if the image aspect ratio of your camera is not 
automatically picked up by Wirecast. In this case, select the correct aspect ratio from 
the menu, click Apply, then click the corresponding icon in the Shot Selection.

5. Click Apply to replace the existing media, then close the Reassign Media window.

Select media

Select or Browse to 
new media

Click Apply and 
close window

Select an aspect ratio
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Introduction
These topics describe the menus, menu items, and keyboard short-cuts in Wirecast. 

Topics
 Wirecast Menu

 File Menu

 Edit Menu

 Switch Menu

 Media Menu

 Sources Menu

 Output Menu

 Layout Menu

 Replay Menu

 Social Menu

 Window Menu

 Help Menu

Wirecast Menu
About Wirecast Displays the version you are running.

Preferences Opens the Preferences window. If the Preferences window is already open, 
it becomes the active window.

Services Presents the Macintosh Services available.

Hide Wirecast Hides all of the windows.

Hide Others Hides all non-application windows.
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Quit Wirecast Closes all documents and exits. If the broadcast is playing, you are asked 
to stop the broadcast first. If a document has not been saved, you are asked to save it.

File Menu
New Creates a new, empty Wirecast document.

Open Displays the Open dialog window for opening a Wirecast document.

Open Recent Displays up to fifteen of the most recently accessed documents. Every 
time a document is opened or saved it is entered into this list.

Import Media Enables you to import media into Wirecast. A new shot is automatically 
created using the new media.

Save Saves the document. If the document has not already been saved, the Save As... 
dialog window is displayed.

Note: Wirecast auto-saves your stream/recording every 20 seconds.

Save As Displays the Save As... dialog window so that the document can be saved using 
a new file name.

Close Window Closes the currently active Wirecast window. If the window is a 
document, all of its Shot Editor windows are closed as well. If Wirecast is still 
broadcasting, you are asked to stop the broadcast. If the document has not been saved, 
you are asked to save the document before closing.

Edit Menu
Undo Reverses your last change in Wirecast. Undo is only available in some windows 
(such as the Shot Editor). Wirecast offers an unlimited number of undo actions (within 
computer memory limitations). Undo information is stored on a per-window basis. 
Also, if you close a window then reopen it, your undo information is lost.

Redo Reverses your last undo action. Redo is only available in some windows (such as 
the Shot Editor). Wirecast offers an unlimited number of redo actions (within computer 
memory limitations). Redo information is stored on a per-window basis. Also, if you 
close a window then reopen it, your redo information is lost.

                         

Edit Shot Opens the Shot Editor. (See Shot Editor). You can also double-click a shot, or 
right-click and select Edit Shot, to open the Shot Editor. The Inspector window is a Shot 
Editor window which always edits the last touched shot. (See Inspector vs. Editor.)

Rename Shot Enables you to rename a shot. You can also right-click a shot and select 
Rename Shot.

STUDIO
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Duplicate Shot Duplicates the currently selected shot. You can also right-click a shot 
and select Duplicate Shot.

Add Shot Creates a new empty shot. You can also right-click a shot and select Add 
Shot.

Delete Shot Deletes the currently selected shot. You can also right-click a shot and 
select Delete Shot.

              

Move To Layer Moves a shot to the selected layer. When shots are created, they are 
assigned to a specific layer. They exist on that layer until they are moved or deleted. You 
can also click and drag a shot to another layer. 

Start Dictation Starts dictation action.

Special Characters Displays the Apple Special Characters interface.

Switch Menu
Go Performs a transition (same action as clicking the Go button).

Transitions Wirecast has two transition buttons that can be assigned any transitions 
(cut, smooth, etc.) that Wirecast supports. The Switch menu lists the currently assigned 
transitions by name. These three transitions can also be selected by pressing the 
control key and either the 1 or 2 key. (See Transition Controls to modify which 
transitions appear in this menu.)

Transition Speed Enables you to select one of five transition speeds ranging from 
Slowest to Fastest.

AutoLive Toggles (turns on and off ) the AutoLive feature. AutoLive is a fundamental 
feature of Wirecast which enables you to control how you make shots become part of 
the live broadcast. (See AutoLive.)

Live/Preview Swap Toggles (turns on and off ) the Live/Preview Swap feature. When 
on, the Live Broadcast and Preview windows trade panes (swap) when the Go button is 
clicked.

Media Menu
Start Playing All Movies Starts playing any movies that are not currently playing.

Pause All Movies Pauses all movies that are currently playing.

Show Asset Manager Displays devices that can be configured. Some devices (cameras, 
etc.) may be configurable. For example, you can configure an iSight camera to manually 
change its focus, contrast, brightness, etc. Other devices have multiple inputs you can 
choose (AlchemyTV Card, etc.). (See Asset Manager.)

STUDIO
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Note: The Configure Devices menu selection is present only if a device is connected 
to Wirecast. The configuration user interface is provided by the device maker. It is 
beyond the scope of this document to describe all of the features available for all 
devices. See the documentation provided with your device on how to configure it.

Sources Menu

New Scoreboard Opens the Source Settings window with a new (untitled) Scoreboard 
selected as a source. Configure the settings and click Apply to create the new source. 

New Remote Desktop Presenter Opens the Source Settings window with a new 
Desktop Presenter selected as a source. Enter the IP address and check With Audio to 
include audio from the desktop. Click Apply to create the new source.

 If Bonjour is not installed on the computer running Desktop Presenter, you may need 
to manually enter the TCP/IP address of that computer. If you want to add a Desktop 
Presenter before it is available you can use this menu option to pre-configure your 
document. You can also change the IP address to a Desktop Presenter in the Asset 
Manager dialog.

New Web Stream  Opens the Source Settings window with a new (untitled) 
WebStream selected as a source. Enter your user name and click Authenticate.

New Local Desktop Presenter Opens a new local Desktop Presenter. This enables you 
to present the whole computer display, or any selected window.

Show Source Settings Opens the Source Settings window. (See Source Settings for 
more detailed information on setting sources.)

Show USB Devices Opens a list of all USB devices.

Note: Since some of the Source Menu items are plug-ins, the order of the items will 
not always be the same.

Output Menu
Output Settings Opens the Output Settings window.

Start/Stop Broadcasting Starts (or stops) broadcasting to the network. You can also 
click the Broadcast button on the Window Bar in the Main Window.

PRO

PRO
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Start/Stop Recording Starts (or stops) recording to disk. If you have not yet configured 
the Output Settings for this document, you are prompted to do so. You can also click 
the Record button on the Window Bar in the Main Window.

               

External Display Output Selects an external display for the output of Wirecast. For 
example, if you have a projector connected to your computer using S-Video, select it 
from this menu to display the output of Wirecast to the projector.

If you have a dual-head graphics card, you can select the second monitor to display 
Wirecast Output. However, if you have two graphics cards, Wirecast may not be able to 
display to any devices (monitors) on the second graphics card.

Virtual Camera Out Enables you to present the output of Wirecast as if it were a 
camera (a virtual camera), allowing it to be automatically detected by other 
applications when they are launched.

Canvas Size Sets the canvas size aspect ratio used when broadcasting a Wirecast 
document.

Note: You should match the output to the canvas size as close as possible to preserve 
video resolution and quality. For example, a 800x600 source results in significant loss 
of quality if an aspect ratio of 640x480 is selected. Using 720x576, which is much 
closer in size, helps preserve video quality. 

Layout Menu

                       

Preview Shows (or hides) the Preview area in the Main window. You can also click the 
Preview icon in the Main window tool bar. 

Master Audio Shows (or hides) the Master Audio controls.

Main Shot List Shows (or hides) the Main Shot List.

Go to Layer Displays the selected layer.  You can also press command + Shift keys with 
the T, F, N, B, or A keys to select a layer. Each of these letter keys represents a layer name: 
Title, Foreground, Normal, Background, and Audio.

Replay Menu
Activate Activates the Create Replay Shot system. When activated, the menu item 
becomes Deactivate. Click Deactivate to deactivate the Create Replay Shot system.

STUDIO

STUDIO
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Replay Mark In Allows you to tighten up your Replay Shot capture. Select Replay Mark 
In to mark the beginning point of your Replay Shot capture.

Create Replay Shot Captures a Replay Shot. The duration of the shot is set in the 
Replay Settings.

Settings Displays the Replay Shot settings window.

For more information about Replay Shots see Replay.

Social Menu
Message Feed Brings up the Social Media dialog.

Create Shot Creates a shot with a social media title in Master Layer 1.

Settings Brings up the Social Media Settings dialog.

Rotate Messages:  Enter the number of seconds that messages rotate into the title.

Refresh Messages: You can choose to manually refresh your message list, or have it 
automatically refreshed at the rate you enter (in seconds).

Use Account: You can choose to receive messages from Facebook, Twitter, or both.

Window Menu
Minimize Minimizes the front-most window.

Zoom Maximizes the front-most window (zooms to the full size of the screen).

                       

Inspector Opens the Inspector window. There is only one Inspector window for each 
document. The Inspector is very similar to the Shot Editor, except it always edits the last 
shot touched. 

STUDIO
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Encoder Presets Opens the Encoder Presets window.

Audio Inspector Opens the Audio Inspector window.

                     

New Layer Window Opens a new Master Layer window for the layer selected.

                       

Camera Preview Shows a preview of all cameras currently connected to your 
computer. Click the Add Camera button to add a camera to the preview window. Use 
the Adjust FPS (frames per second) slider to adjust how realistically the camera image 
responds to motion. (Keep in mind that the greater the FPS the greater the processing 
power required to render the preview.) Use the Adjust Size slider to change the size of 
the camera image. You can also right-click on any camera preview source and select 
Remove.

    

Document Windows All open document windows are listed at the bottom of this 
menu.

Help Menu
Search Enables you to search the help system for any topic or key word.

Wirecast Help Opens the online help version of the User Guide.

Open Wirecast PDF User Guide Opens the PDF version of the User Guide.

Open Tutorial HTML Opens the Wirecast Tutorial in your browser. To follow the 
tutorial, you'll need to Create a Document for the Tutorial as well.

STUDIO

PRO

STUDIO

STUDIO

Add Camera

Adjust FPS Adjust Size

Right-click to 
remove source
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Create Document for Tutorial Creates a new Wirecast Document which contains the 
media necessary for following the Tutorial.

Buy/Upgrade Opens Buy Upgrade in the Preferences window. This window allows you 
to purchase licenses and to activate or deactivate them.

Provide Feedback Opens the Telesteam Website feedback page where you can enter 
any feedback you may have about our product or company.

Send Support Information Opens a Support Assistant dialog window. To create a new 
support ticket, select Create a support ticket. The information is sent to the Telesteam 
support team for evaluation. If you have been previously issued a case number, select 
Link with existing support case # and enter your case number.  You can also select Do not 
receive follow-up from Telestream. This enables you to send support information to 
Telestream without receiving a response. Click Save Report to save the information to a 
file on your computer. Click Send Report to send the information to Telestream. 

Note: You must click Send Report to create a ticket. If you click Save Report, a ticket will 
not be created.

         

Visit Telesteam Web Site Opens the Telesteam Website home page.

Visit Wirecast / Desktop Presenter Download Page Opens the Telesteam Website 
download page for Desktop Presenter.

Acknowledgments Opens an on-line help to acknowledgments.
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Broadcasting
Introduction
Note: Wirecast will not prevent your computer from entering sleep mode. Therefore, 
to ensure uninterrupted streaming, you should disable sleep mode on your computer 
while using Wirecast.

Note: To avoid a decrease in video quality, Wirecast should not be used at CPU usage 
above 80%. See the Telesteam  Web site for suggested configurations.

Topics
 Canvas Size
 Virtual Camera
 Configuring Output Settings
 Configuration
 Encoder Presets
 Flash RTMP Server
 Flash RTMP Server
 Flash To Akamai
 Flash To Microsoft Azure, Brightcove, Limelight, Sermon.net
 Flash To Bambuser, Churchstreaming.tv,  DaCast Streaming Services, High School Cube,  

iNK Barrel Video, Livebeats, make.tv, Meridix Sports Network,  Netbriefings, ShowCaster,  
Streaming Media Hosting, StreamVu,  Stretch Internet, Sunday Streams,  Tulix, Ustream

 Flash To Microsoft Azure, Brightcove, Limelight, Sermon.net
 Flash To YouTube
 Flash To Zixi
 Streaming
 Record To Disk
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Canvas Size
The first menu item in the Output menu is Canvas Size. When Output > Canvas Size is 
selected, a drop-down menu with various canvas sizes is displayed allowing you to 
select the canvas size you want. You can also select Auto. This automatically sets the 
canvas size to the highest resolution that was selected when the encoder was chosen.

   

Note: Canvas size selection 1080p Anamorphic (1440x1080) is a narrower (1440) 
display stretched to display as 1080.

There is also a Custom option that enables you to set the canvas width and height.

Wirecast can manage a wide variety of input sources, enabling you to have several live 
camera sources. However, really high-quality video sources can cause more harm than 
good. For example, an HD camera feed into a Wirecast canvas that is set to HD 
resolution and then broadcast out in HD, requires a lot of work for the graphics 
processor. If the frame rate starts to drop but the CPU usage stays steady, it creates a 
bottleneck. The solution is to reduce the frame size going through Wirecast. Therefore, 
there is no need to bring input video in at HD resolution if Wirecast is streaming out a 
lower resolution. 

Select Auto (optionally)

Select a custom size

Click Canvas Size

Select a canvas size

Set width and height
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Keep in mind that resizing down is good but resizing up reduces quality. As a rule, you 
should try to keep your resolution as constant as possible from source to output. There 
is no benefit from using an HD camera if you’re only broadcasting a low resolution 
stream. This only increases the work your computer must do without any increase in 
output quality.

Virtual Camera 
Wirecast enables you to present the output of Wirecast as if it were a camera (a virtual 
camera), allowing it to be automatically detected by other applications when they are 
launched. To setup Wirecast as a virtual camera, select Output > Virtual Camera Out, 
then select the output resolution to use. You can also select Match Canvas to cause the 
resolution to be the same as the current canvas size.

   

Once you have selected an output resolution, select Start to make Wirecast output 
available to other applications on your computer.

Some of the applications Wirecast can work with using virtual camera are:

• Google+ Hangouts 

• Skype

• GoToMeeting

Note: Virtual Camera only works with one application at a time.

The Virtual Camera menu also provides two additional options: DirectShow Audio and 
Virtual Microphone. 

DirectShow Audio  When selected, outputs DirectShow audio. 

Virtual Microphone When selected, enables you to present the output of Wirecast as if 
it were a microphone (a virtual microphone), allowing it to be automatically detected 
by other applications when they are launched.

Select a resolution

Select Virtual Camera Out
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Note: After selecting Virtual Microphone, you must re-start Wirecast to enable Virtual 
it’s operation. 

Note: Virtual Microphone can only be installed during Wirecast installation.

Configuring Output Settings
To configure output settings select Output > Output Settings (or press the Command+Y 
keys). When the dialog box displays, select a destination and click OK to open the 
Output Settings window. 

       

You can also click More to display a list of all available destinations. Check the checkbox 
for each destination you want to include in the destination menu list.

         

Select Destination

Click OK

Check 
destinations to 
include them in 
Destination 
menu list
Wirecast User Guide | 142779



Broadcasting
Configuration

189
The Output Settings window displays the destination you selected. Each destination 
window has a unique set of controls including a way to authenticate your connection.

        

Multiple Output Settings
Wirecast enables you to specify many output settings for your presentation. This means 
you may configure Wirecast to broadcast multiple data rates simultaneously, or even 
broadcast and record with different encoders at the same time. You can also broadcast 
to multiple Flash destinations while recording to disk.

At the top of the Output Settings window is a list of the current settings. Uncheck the 
checkbox of any setting you want removed from your broadcast. You can add as many 
output settings as you need, but keep in mind that each additional destination will 
require more system resources.

Click the Gear icon to access actions that enable you to create reference movies you can 
distribute to your viewers. Each destination type provides a unique set of actions.

Configuration
There are two items to configure before broadcasting: Destination and Encoding.

When you broadcast with Wirecast, you must pre-configure at least one destination. A 
destination can be a broadcast server, content distribution network or local disk 
recording.

The Encoder determines how your presentation is encoded (or compressed). There are 
many options available. Wirecast simplifies this process by providing several simple 
presets to choose from. (See also The Encoder Presets Window).
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Encoder Presets
The Encoder menu is located near the top of the Output Settings window. The 
Destination menu is located above the Encoder menu. The More button and Gear 
menu provide optional settings.

       

More Click More to display a list of all available destinations. Check the checkbox for 
each destination you want to include in the destination menu list.

      

Encoding menu

More button

Destination menu

Gear menu

Check 
destinations to 
include them in 
Destination 
menu list
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Filter Select Filter from the Gear menu to display a check list of encoder presets. Check 
the presets you want to display in the Encoder presets menu. Click Save when finished.

     

New Preset Select New Preset from the Gear menu to create a new encoder preset. 
Enter a name for your new preset and click OK. (See Creating New Presets).

    

Check presets

Click Save

Enter name

Click OK
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View Details Select View Details from the Gear menu to modify an encoder preset. (See 
Creating New Presets). One important option is Strict Constant Bitrate.  When checked, 
the bitrate is strictly held at the bitrate entered in Average bit rate.

     

More Click the More button to display a check list of destinations. Check the 
destinations you want to display in the Destination menu. Click Save when finished.

        

Check (optionally) 
Strict Constant bitrate

Check destinations

Click Save
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P 
Multicast and Unicast
You can select Multicast or unicast from the Destination menu. Multicast lets you 
broadcast to multiple computers simultainiously. Unicast lets you broadcast to a 
specific computer.

You need to create an SDP File, and you must do so every time you change any option 
on this page (including the encoder preset). To create an SDP file click the gear icon and 
select Save SDP File, navigate to the desired location, and click Save in the Save File 
dialog window. The SDP file must be given to the user to place on the computer that 
receives your broadcast. 

During multicast, your broadcasting computer sends data across your local network, 
identifying it as a broadcast that it has no specific destination. Since many applications 
could be doing the same thing, the broadcasting computer must have a unique way of 
defining the data that is being multicast. This enables clients to choose between the 
available multicast streams.

The multicast protocol uses unique addresses, one for video and one for audio. 
Although these unique addresses look like TCP/IP addresses, they are not. Instead, they 
provide a way to define uniqueness among all multicast data flowing over the network. 
Once the broadcasting computer is streaming this data through the local network, any 
computer on the network can receive it.

The SDP file becomes the glue between your broadcast computer and the viewer 
computers. The SDP file contains multicast addresses, encoding format, and other 
important information.

Select Multi 
or Unicast

Select Save SD
file
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Flash RTMP Server
Wirecast can stream to an RTMP/ H.264-compatible streaming server (Flash Media 
Server, Wowza Media Server, etc.). Flash Players earlier than Flash 9, Update 3 (Dec 
2007), may not be able to view the H.264 based streams.

To configure Flash Media Streaming, follow these steps:

1. Select Destination > RTMP Server.

2. Select an encoder. 

3. Enter the Address to the RTMP server. (This is the same as the FMS URL in Flash 
Media Server.) The default RTMP port is 1935, but you may need to configure your 
firewall to allow connections on this port.

4. Wirecast can import a Flash Media Encoder configuration file (XML file). Click Open 
FMLE XML File, and navigate to the configuration file and select either version 2.5 or 
version 3.0. Wirecast reads the Address and Stream information from that file. Many 
online streaming services offer FMLE configuration files which Wirecast can use.

Note: Only the Address and Stream information from the XML configuration file is 
used. No Encoding information is imported.

5. Click OK to save your settings:

Click and 
navigate to the
configuration 
file

Click OK

Select a 
Destination

Enter the 
Address to the
RTMP server

Select an 
encoder
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CDN Partners
Listed below are the Content Distribution Network (CDN) partner destinations available 
in Wirecast. Most destinations share a common user interface and only require a user 
name and password. Destinations that do not conform to this paradigm, or require 
additional parameters, are presented separately.

Note: The list of CDN partners in Wirecast is subject to change at any time. 

Flash To Bambuser,                     Churchstreaming.tv, 
DaCast Streaming Services,    High School Cube, 
iNK Barrel Video,                          Livebeats,         
make.tv,                                           Meridix Sports Network,    
Netbriefings,                                  ShowCaster,   
Streaming Media Hosting,       StreamVu,   
Stretch Internet,                           Sunday Streams, 
Tulix,                                                  Ustream

To stream to one of these CDN partners, follow these steps:

1. Select a CDN partner from the Destination menu.

2. Select an encoder. 

3. Enter your username.

4. Click Authenticate to enter your password and generate the RTMP URL. You only 
need to do this one time because Wirecast stores the channel information for 
future streams. The default RTMP port is 1935. You may need to configure your 
firewall to enable connections on this port.

Note: If you do not have a username and password, you can sign up with a CDN 
partner by clicking Sign Up.

5. Select your channel.

6. Optionally, enter a Stream Delay value. This provides a time buffer between your 
live stream from Wirecast and the actual broadcast itself. You can set the delay from 
0 to 999 seconds. However, greater delays require greater memory use. The amount 
of memory used is displayed when you enter the amount of delay.
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7. Click OK when finished. 

   

Select an encoder 

Select a CDN 
partner

Click Authenticate and 
enter password

Select Channel

Enter user name

Enter delay (optionally)

Click OK
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Flash To Microsoft Azure, Brightcove,   Limelight,   
Sermon.net 

To stream to one of these CDN partners, follow these steps:

1. Select a CDN partner from the Destination menu.

2. Select an encoder. 

3. Enter the domain name or IP address (this is provided by the CDN partner).

4. Enter the stream name of your broadcast (this is provided by the CDN partner).

5. Click Set Credebtials to enter your password and generate the RTMP URL. You only 
need to do this one time because Wirecast stores the channel information for 
future streams. The default RTMP port is 1935. You may need to configure your 
firewall to enable connections on this port.

Note:  If you do not have a stream name and password, you can sign up with the CDN 
partner by clicking Learn More.

6. Optionally, enter a Stream Delay value. This provides a time buffer between your 
live stream from Wirecast and the actual broadcast itself. You can set the delay from 
0 to 999 seconds. However, greater delays require greater memory use. The amount 
of memory used is displayed when you enter the amount of delay.

7. Click OK when finished.

        

Select an 
encoder 

Select host 
server

Enter Stream name

Enter Address

Click Set 
Credentials

Enter delay (optionally)

Click OK
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Flash To Akamai 
To stream to Akamai, follow these steps:

1. Select Akamai from the Destination menu.

2. Select an encoder. 

3. Enter your Akamai Stream ID and Event Name.

4. Enter your Akamai Angle and Video Rate.

5. Enter your user name.

6. Click Authenticate to enter your password and generate the RTMP URL. You only 
need to do this one time because Wirecast stores the channel information for 
future streams. The default RTMP port is 1935. You may need to configure your 
firewall to enable connections on this port.

Note: If you do not have a username and password, you can sign up with Akamai by 
clicking the Akamai icon, or by clicking Sign Up.

7. Optionally, enter a Stream Delay value. This provides a time buffer between your 
live stream from Wirecast and the actual broadcast itself. You can set the delay from 
0 to 999 seconds. However, greater delays require greater memory use. The amount 
of memory used is displayed when you enter the amount of delay.

8. Click OK. 

   

Select an encoder 

Select Akamai

Click Authenticate 
and enter password

Enter angle and 
video rate

Enter Stream ID 
and Event Name

Enter a user name

Enter delay (optionally)
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Flash To TwitchTV
To stream to TwitchTV, follow these steps:

1. Select TwitchTV from the Destination menu.

2. Select an encoder. 

3. Enter your TwitchTV username.

4. Click Authenticate to enter your password and generate the RTMP URL. You only 
need to do this one time because Wirecast stores the channel information for 
future streams. The default RTMP port is 1935. You may need to configure your 
firewall to enable connections on this port.

Note: If you do not have a username and password, you can sign up with TwitchTV by 
clicking the TwitchTV icon or by clicking Sign Up.

5. A default path is automatically provided for the RTMP Ingest URL. Use this URL 
unless you have received a different one from TwitchTV.

6. Optionally, enter a Stream Delay value. This provides a time buffer between your 
live stream from Wirecast and the actual broadcast itself. You can set the delay from 
0 to 999 seconds. However, greater delays require greater memory use. The amount 
of memory used is displayed when you enter the amount of delay.

7. Click OK when finished 

    

Select  Encoder 

Select TwitchTV

Click Authenticate 
and enter password

Enter Username

Enter delay (optionally)
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Flash To YouTube 
To stream to YouTube, follow these steps:

1. Select YouTube from the Destination menu.

2. Select an encoder. 

Note: YouTube may not yet support OpenIDs via this API. The solution is to download 
the FMLE configuration file from YouTube and use the Flash Media Server interface.

3. Click Authenticate to enter your username and password and generate the RTMP 
URL. You only need to do this one time because Wirecast stores the channel 
information for future streams. The default RTMP port is 1935. You may need to 
configure your firewall to enable connections on this port.

Note: If you do not have a username and password, you can sign up with YouTube by 
clicking the YouTube icon or by clicking Sign Up.

4. Select your YouTube event.

5. Optionally, enter a Stream Delay value. This provides a time buffer between your 
live stream from Wirecast and the actual broadcast itself. You can set the delay from 
0 to 999 seconds. However, greater delays require greater memory use. The amount 
of memory used is displayed when you enter the amount of delay.

6. Click OK. 
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Flash To Zixi 
To stream to Zixi, follow these steps:

1. Select Zixi from the Destination menu.

2. Select an encoder. 

3. Enter Zixi connection information.

4. Enter your Zixi channel name and password.

5. Click apply to generate the RTMP URL. You only need to do this one time because 
Wirecast stores the channel information for future streams. The default RTMP port 
is 1935. You may need to configure your firewall to enable connections on this port.

Note: If you do not have a username and password, you can sign up with Zixi by 
clicking the Zixi icon, or by clicking Sign Up.

6. Optionally, enter a Stream Delay value. This provides a time buffer between your 
live stream from Wirecast and the actual broadcast itself. You can set the delay from 
0 to 999 seconds. However, greater delays require greater memory use. The amount 
of memory used is displayed when you enter the amount of delay.

7. Click OK. 

    

Select an encoder 
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Streaming
To stream your presentation, click the Stream button at the top of the Main window.

    

If you have not already selected a destination and logged into it, a dialog box displays. 
Select a destination, log in when asked to do so, then click OK. 

        

The Stream LED will blink until a connection is made. Once you are connected the LED 
turns full on and a red box is placed around the Stream button. If you cannout connect 
an error message will display. 

        

Connection strength bars are displayed on the right. Fewer bars indicates a weaker 
(slower) connection.

        

Click Stream Click Record

Select Destination

Click OK

Red LED and red box

Green connection 
strength bars
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If the connection is ever broken, the green bars are reduced to a single red bar, then 
immediately a no connection icon is displayed in place of the bars.

        

When the connection recovered, the no connection icon is replaced with the green bars.

Click Stream again to stop streaming. You can also record your broadcast by clicking 
Record.

Record To Disk
If you want to archive your stream, you can use the Record To Disk destination.

Note: Wirecast auto-saves your Stream/recording every 20 seconds.

To record to disk, follow these steps:

1. Click the Record button at the top of the Wirecast Main window.

    

2. When the dialog box displays, select Record to Disk and click OK.

        

3. When the Output Settings window displays, Select Record To Disk (for MP4 or 
Windows Media, MOV)

4. Select an encoder.

5. Click Browse or enter the path to where you want your recording located.

6. Check the Auto Increment Filenames checkbox (optionally), if you want your 
filename to have an incremental number appended to the end of it. This causes a 
new file to be created every time you start recording to disk. If you do not check 
this checkbox, then your previous file is overwritten.

7. Click OK.

No connection icon

Click Record

Select Record to Disk

Click OK
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Enter filename or navigate 
to file Location

Check Auto Increment 
Filename (optionally)

Select Record To Disk

Select an encoder

Click OK
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Introduction

            

Wirecast supports a wide variety of encoders (also known as codecs).

An encoder is a program that compresses the audio and/or video output of Wirecast for 
broadcast. Without an encoder, the uncompressed data is too large to successfully 
broadcast across a network. This is why encoders are so important.

The settings for encoders range from simple to very complex. Because of this, Wirecast 
offers presets of the most common settings for encoders. This provides a starting point, 
reduces complexity, and enables you to experiment and adjust settings as you test your 
broadcast.

Note: Encoder Presets can also be edited from the Output Settings window. To do 
this select Output > Output Settings, click the gear icon, then choose View Details from 
the drop-down menu.

Topics
 The Encoder Presets Window



 MainConcept H.264

 x264

The Encoder Presets Window
To open the Encoder Presets window, select Window > Encoder Presets. The Encoder 
Preset menu at the top of the window provides a list of encoder presets. Select a preset 
to edit from this list.

STUDIO
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Creating New Presets
The default encoder presets cannot be changed. However, you can make a copy of any 
preset, modify it as needed, and save it under a new name. You can refer back to the 
default presets at any time since they are never modified.

To create a new preset, you must make a copy of an existing preset. To do this, select an 
existing preset from the Encoder Presets menu that is close to what you what you need, 
change settings as needed, then click Save As to save the preset with a new name.

Profile Options
Many encoder presets enable you to select one of three profiles: Baseline, Main, or 
High.

Baseline Profile (BP) Baseline profile is primarily for low-cost applications that require 
additional data loss robustness. This profile is used in some video conferencing and 
mobile applications. It includes all features supported in the Constrained Baseline 
Profile, plus three additional features used for loss robustness (or for other purposes 
such as low-delay multi-point video stream compositing). The importance of this 
profile has faded somewhat since the definition of the Constrained Baseline Profile in 
2009. All Constrained Baseline Profile bitstreams are also considered to be Baseline 
Profile bitstreams, since these two profiles share the same profile identifier code value.

Main Profile (MP) The Main profile is used for standard-definition digital TV broadcasts 
that use the MPEG-4 format as defined in the DVB standard. It is not, however, used for 
high-definition television broadcasts, since the importance of this profile faded when 
the High Profile was developed in 2004 for that application.

High Profile (HiP) The High profile is the primary profile used for broadcast and disc 
storage applications, particularly for high-definition television applications. For 
example, this profile is used by the Blu-ray Disc storage format and the DVB HDTV 
broadcast service.
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MainConcept H.264

              

To modify a MainConcept H.264 preset, follow these steps:

1. Open the Encoder Presets window.

2. Select an encoder preset from the Encoder Presets menu.

Note: To use a newly created preset (See Creating New Presets).

3. Check the Video Encoding checkbox. When checked, the video for your broadcast 
is encoded. When unchecked, a blank video screen is provided. This is the preferred 
method of producing audio-only broadcasts.

4. Select the Main Concept H.264 encoder from the Encoder menu.

5. Enter the width of your broadcast video.

6. Enter the height of your broadcast video.

7. Select the desired frames per second (FPS) of your broadcast. This value is a target 
value for the encoder and the exact value is not guaranteed.

8. Enter the average bit rate in Kbits (1000 bits) per second. This is the target bit rate of 
your video. Higher numbers provide better quality. The connection speed of your 
audience is a significant factor in determining your target bit rate. The encoder 

STUDIO

Select a preset

Select Main 
Concept H.264
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compresses the video to approximate this target. However, at different times 
during your broadcast the bit rate may be higher or lower than the target rate.

9.  Select an encoder profile from the Profile menu. Three profiles are provided: 
Baseline, Main, and High. The Baseline profile is commonly used in mobile 
applications. It is also used in other applications which operate with limited 
processing power, storage capacity, and/or bandwidth. The Main profile is 
appropriate for general-purpose applications of broadcast media, such as high-
bandwidth Internet broadcasting. The High profile provides the highest broadcast 
quality encoding.

10.  Key Frame (optionally) allows you to enter the number of frames. A movie is a 
sequence of images and each image is called a frame. To compress video data, 
most encoders take a frame and make it a reference (also known as a key). This 
keyframe is sent as part of the broadcast, and all of the data after that keyframe is 
relative to it. The benefit of this is that the compressor only needs to send what has 
changed since the last keyframe. The main drawback of this is that over time it 
becomes harder for the encoder to distinguish the frame-difference information, 
especially if there is a lot of motion in the video. Another drawback is if your 
viewer’s computer misses a keyframe, the video is distorted until the next keyframe 
is sent. However, you can control how often the encoder makes a new keyframe by 
setting the number of frames. The more keyframes you broadcast, the more 
bandwidth required and less compression, but results in better quality video.

11.  Check (optionally) the Timecode Every checkbox and enter the number of frames 
between timecodes. Wirecast can generate timecodes embedded in the flash 
stream. If a frames value of zero is entered, the timecode is never sent. Wirecast 
sends metadata along with the frames. This data looks like an ONFi call. Various 
timecodes and timestamps are also sent with the stream.

12. Check (optionally) Strict Constant Bitrate.  When checked, it forces the Average bit 
rate (see item 8 above) to maintain the exact bit rate entered. CBR pads the data 
(when necessary) to meet exact bitrate specified. Disabling CBR can result in 
slightly improved quality and decrease file size, but at the cost of greater bitrate 
fluctuations which could prove troublesome for certain streaming destinations. 
Selecting this option for recording is not recommended because it can result in 
decreased quality and larger files, with no real benefit.

13. Check (optionally) Keyframe aligned.   When checked, it facilitates adaptive bitrate 
streaming by ensuring that keyframes from multiple streams are in sync, along with 
the keyframes timestamp, DTS and PTS values. But this is true only if those other 
streams also have the option turned on and have the same keyframe interval. To 
accomplish this, Wirecast disables scene detection and manually inserts the 
keyframe at the exact keyframe interval specified. Therefore, to ensure quality and 
smooth switching in the player, the keyframe interval should be in the 1 to 4 
second range. When Keyframe Aligned is enabled, absolute timestamp is also 
enabled.

14.  Check (optionally) the Audio Encoding (AAC) checkbox. When checked, the audio 
for your broadcast is included. When unchecked, audio is absent. This is the 
preferred method of producing video-only broadcasts because the presence of 
silent audio uses bandwidth.
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15.  Select the number of channels: Mono or Stereo. Mono uses less bandwidth than 
stereo, but stereo is more pleasing to the listener.

16.  Select the audio bit rate, in Kbits (1000 bits) per second, from the Target Bit Rate 
menu. This is the target bit rate of your audio. Higher numbers provide better 
quality. The connection speed of your audience is a significant factor in 
determining your target bit rate. The encoder compresses the audio to 
approximate this target. However, at different times during your broadcast the bit 
rate may be higher lower than the target rate. The total broadcast bit rate is a 
function of video bit rate plus audio bit rate.

17.  Select the audio sample rate, in kHz (1000 Hz) per second, from the Sample Rate 
menu. This value specifies how many thousands of times per second to sample the 
audio in the broadcast. Higher values provide better quality sound, but at greater 
bandwidth.

18.  Click Save to save your settings.
Wirecast User Guide | 142779



Encoder Presets
x264

210
x264

              

Note: The x264 implementation of the H.264 standard results in better quality and 
lower CPU usage for any given bitrate , but at the cost of higher memory usage. The 
default implementation is based on the Mainconcept codec and uses less memory.

To modify a Flash x264 preset, follow these steps:

1. Open the Encoder Presets window.

2. Select an encoder preset from the Encoder Presets menu.

Note: To use a newly created preset (See Creating New Presets).

3. Check the Video Encoding checkbox. When checked, the video for your broadcast 
is encoded. When unchecked, a blank video screen is provided. This is the preferred 
method of producing audio-only broadcasts.

4. Select x264 for Encoder.

5. Enter the width of your broadcast video.

6. Enter the height of your broadcast video.

STUDIO

Select a preset

Select X264
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7. Select the desired frames per second (FPS) of your broadcast. This value is a target 
value for the encoder and the exact value is not guaranteed.

8. Enter the average bit rate in Kbits (1000 bits) per second. This is the target bit rate of 
your video. Higher numbers provide better quality. The connection speed of your 
audience is a significant factor in determining your target bit rate. The encoder 
compresses the video to approximate this target. However, at different times 
during your broadcast the bit rate may be higher lower than the target rate.

9. Select encoding quality (Ultra fast to Very slow encoding). Slower encoding results 
in better quality.

10. In the x264 command line options edit box, enter any command line options you 
want included. A list of the command line options can be found at:
 http://mewiki.project357.com/wiki/X264_Settings.

11.  Select an encoder profile from the Profile menu. Three profiles are provided: 
Baseline, Main, and High. The Baseline profile is commonly used in mobile 
applications. It is also used in other applications which operate with limited 
processing power, storage capacity, and/or bandwidth. The Main profile is 
appropriate for general-purpose applications of broadcast media, such as high-
bandwidth Internet broadcasting. The High profile provides the highest broadcast 
quality encoding.

12. Key Frame (optionally) allows you to enter the number of frames. A movie is a 
sequence of images and each image is called a frame. To compress video data, 
most encoders take a frame and make it a reference (also known as a key). This 
keyframe is sent as part of the broadcast, and all of the data after that keyframe is 
relative to it. The benefit of this is that the compressor only needs to send what has 
changed since the last keyframe. The main drawback of this is that over time it 
becomes harder for the encoder to distinguish the frame-difference information, 
especially if there is a lot of motion in the video. Another drawback is if your 
viewer’s computer misses a keyframe, the video is distorted until the next keyframe 
is sent. However, you can control how often the encoder makes a new keyframe by 
setting the number of frames. The more keyframes you broadcast, the more 
bandwidth required and less compression, but results in better quality video. 

13. Check (optionally) Strict Constant Bitrate.  When checked, it forces the Average bit 
rate (see item 8 above) to maintain the exact bit rate entered. CBR pads the data 
(when necessary) to meet exact bitrate specified. Disabling CBR can result in 
slightly improved quality and decrease file size, but at the cost of greater bitrate 
fluctuations which could prove troublesome for certain streaming destinations. 
Selecting this option for recording is not recommended because it can result in 
decreased quality and larger files, with no real benefit.

14. Check (optionally) Keyframe aligned.   When checked, it facilitates adaptive bitrate 
streaming by ensuring that keyframes from multiple streams are in sync, along with 
the keyframes timestamp, DTS and PTS values. But this is true only if those other 
streams also have the option turned on and have the same keyframe interval. To 
accomplish this, Wirecast disables scene detection and manually inserts the 
keyframe at the exact keyframe interval specified. Therefore, to ensure quality and 
smooth switching in the player, the keyframe interval should be in the 1 to 4 
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second range. When Keyframe Aligned is enabled, absolute timestamp is also 
enabled.

15.  Check (optionally) the Timecode Every checkbox and enter the number of frames 
between timecodes. Wirecast can generate timecodes embedded in the flash 
stream. If a frames value of zero is entered, the timecode is never sent. Wirecast 
sends metadata along with the frames. This data looks like an ONFi call. Various 
timecodes and timestamps are also sent with the stream.

16.  Check (optionally) the Audio Encoding (AAC) checkbox. When checked, the audio 
for your broadcast is included. When unchecked, audio is absent. This is the 
preferred method of producing video-only broadcasts because the presence of 
silent audio uses bandwidth.

17.  Select the number of channels: Mono or Stereo. Mono uses less bandwidth than 
stereo, but stereo is more pleasing to the listener.

18.  Select the audio bit rate, in Kbits (1000 bits) per second, from the Target Bit Rate 
menu. This is the target bit rate of your audio. Higher numbers provide better 
quality. The connection speed of your audience is a significant factor in 
determining your target bit rate. The encoder compresses the audio to 
approximate this target. However, at different times during your broadcast the bit 
rate may be higher lower than the target rate. The total broadcast bit rate is a 
function of video bit rate plus audio bit rate.

19.  Select the audio sample rate, in kHz (1000 Hz) per second, from the Sample Rate 
menu. This value specifies how many thousands of times per second to sample the 
audio in the broadcast. Higher values provide better quality sound, but at greater 
bandwidth.

20.  Click Save to save your settings.
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Introduction
These topics provide helpful information about how to prepare for creating great 
presentations.

Topics
 Overview

 High Quality Audio

 Good Lighting

 Broadcast Settings

Overview
There are many ways to make a good live event even better. But this appendix focuses 
on two main things to remember about video streaming: 

• High Quality Audio Input Great looking video with poor audio input appears 
unprofessional. 

• Good Lighting Poor lighting can ruin an otherwise excellent live event. If you are 
doing chroma keying, this may become the most important part of your setup. 

When video is saved to disk or sent over the network, it needs to be compressed. The 
compression process is done by encoders (codecs) which are optimized to work with 
clean input data. This means that if the audio or video is muddy to start with, it remains 
muddy after compression. Some codecs may even highlight poor input because the 
algorithm is built to look for differences.

Your goal should be to give the best possible quality audio and video to the 
compression process as possible. This means making sure what you see in the Live area 
is the best possible quality because Wirecast takes exactly what you see and sends it to 
the codecs.
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High Quality Audio
Audio has an artistic aspect to it. You can make a great live event even better by 
remembering to focus on a few details. Here are some suggestions on producing clean 
audio.

• Use a Good Microphone Though this may sound obvious, a good microphone can 
make a huge difference. Most DV cameras have an audio input for an external 
microphone. Use this, whenever possible, instead of the built-in microphone that 
comes with the camera. Built-in microphones are usually not good quality and tend 
to pick up hum from the electronics inside the camera. Even when it is not a great 
microphone, an external microphone almost always sound better.

• Use a Microphone Splitter If you are doing an interview with one camera, you can 
use two microphones with a splitter (less than $5). This often gives better results 
than one omni-directional microphone at a distance. You can also use a dual lapel 
microphone with a splitter.

• Position the Microphone Properly Place any microphone as close to the sound 
source as possible, even when using omni-directional microphones, because sound 
volume decreases greatly the farther away the microphone is placed. Stronger sig-
nals coming into the microphone results in better quality.

• Use Lapel Microphones Even inexpensive (less than $20) lapel microphones can 
make a huge difference because it places the microphone much closer to the per-
son speaking.

• Control Environmental Noise If a chair squeaks, use a different one. If you have a 
wood floor and you can hear people shuffling their feet as they talk, put down a 
rug. Do whatever it takes to keep noise at a minimum. Microphones pick up every-
thing.

Good Lighting
Do not underestimate the power of lighting. When an event is shot outdoors, a great 
deal of attention goes into lighting. For professionals, lighting is viewed as an artistic 
task. Many people make their living controlling lighting, so there is a lot to it. Here are a 
few suggestions to help you obtain reasonably good lighting:

• If you are using only one lighting source, do not shine it directly on your subject. 
You should diffuse the light by bouncing it off of a wall or by shining it through 
opaque material.

• Avoid deep shadows. Make sure you fill all areas of your subject with light. Some-
times this requires adjusting the light to bounce off a different wall or use two 
lights. Placing a light low and another one high is often a good way to light evenly.

• Do not light too evenly. If you evenly light a set, you may actually be worse off than 
not lighting the set at all. Take a sample shot and see if it looks natural. Good light-
ing usually has a little more light coming from above than any other direction. You 
should very rarely light just from below a subject.
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• Beware of having too much light on your subject. If your subjects are people and 
you must use a lot of light, use make-up to compensate for the overly bright light-
ing. This is not necessarily a bad thing, but you must choose how much effort you 
want to go through to make a good live event. If your lighting balance is excellent, 
you will can avoid make-up on your subjects. The key in adjusting the lighting is to 
look at your subject and make sure they do not look washed out.

• Watch professional events and learn from them. As you watch, notice the lighting 
instead of watching the program. Notice how they employ the suggestions listed 
above.

These guidelines might seem to suggest subtle improvements, but good lighting can 
make an amateur video look professional and a professional video look fabulous. The 
important thing to remember is that one or two properly placed lights makes a huge 
difference in the quality of your live event. 

Triangular Lighting
One advanced and very effective approach to good lighting is known as triangular 
lighting (or three light setup). Although this may sound complicated, it is actually quite 
simple. It involves setting up three lights (sometimes using natural light as one of the 
light sources), in a configuration that achieves a good balance. Here are the main 
elements of Triangular Lighting:

• Main Light (Key Light) This is the strongest of your lights and does most of the 
work. This light normally comes from one side of the camera (the left, for example) 
and is slightly raised. However, using just the main light results in shadowing.

• Fill Light This is a soft light placed directly in front of the subject. It removes shad-
ows and fills in the image. It is usually direct and usually comes from the same 
direction as the camera (or just to the side and behind it). It could be, for example, 
placed on the same level as the head of a person you are lighting. If you use only a 
fill light, your subject might appear too dark. The only purpose of a fill light is to add 
to the main light by filling in shadows. If your key light comes from the left of your 
camera, your fill light should come from the right, and vice versa.

• Back Light (Rim Light) This light is directed from behind the subject and above it. 
This is the hardest light to explain, but the best way is to describe it as an accent of 
your subject. If you look at a typical high school yearbook picture, you will notice 
that the top-left (or top-right) part of each head shot has a highlight of light in it. 
This light is the back light. It is also called a rim light because it makes a slight rim 
around the edge of the head of your subject. This light normally comes from 
behind and above the subject, and it is focused. Make sure it is not directed at the 
camera.

Most serious lighting starts with these three basic lights. There are also some great 
Websites that describe these techniques in great detail.
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Broadcast Settings 
Once you have good video and audio coming into Wirecast, the final item of 
importance is make sure the Broadcast Settings are configured correctly for your 
presentation. Though there are many broadcast parameters to modify, there are three 
that are the most important: bandwidth, motion, and encoder settings.

Bandwidth
The first item of importance is knowing how much bandwidth is available. Bandwidth is 
how much data you can broadcast from your computer. This depends on the speed of 
your network connection and the type of connection your viewers are using. More 
specifically, it is the minimum speed between you and all of your viewers. For example, 
if you have one viewer who is using a dial-up modem, for that viewer to see good 
quality you must broadcast at Modem speed.

Thus, you must know who your viewers are and what kind of connection they have. 
This may be difficult to know because you must determine if their connection is cable 
modem or DSL and whether or not they reside on your local network.

In some situations, you are broadcasting for just your local network (in an office 
building, for example). In this case you should discuss your plans with your network 
administrator and verify that you will not disrupt the network with your broadcasts. Ask 
them what your upper limit bandwidth should be. Your available bandwidth is the 
minimum of what you can upload, combined with what your viewers can download.

Motion
Once you know your bandwidth, you need to decide whether or not your video 
contains a lot of motion. Motion is how much things move around in your video 
presentations. An interview is considered low motion. A sports event, however, would 
probably be high motion. Wirecast comes configured with defaults to help ease your 
configuration task. Choose a default configuration that meets your motion (and 
bandwidth) constraints.

Encoder Settings
The parameters of the encoders are quite technical and can be overwhelming. It is 
beyond the scope of this document to describe the delicate balance required in setting 
them. There are professionals who fine-tune encoders to do exactly what is required. 
The Wirecast default settings are generally optimal for the various network 
environments. (See Encoder Presets for information on changing the encoder settings.)
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Overview
Portions of this software may utilize the following copyrighted material, the use of 
which is hereby acknowledged:

 Darwin streaming server

 FFmpeg Project

Darwin streaming server
APPLE PUBLIC SOURCE LICENSE Version 2.0 - August 6, 2003 Please read this License 
carefully before downloading this software.

By downloading or using this software, you are agreeing to be bound by the terms of 
this License. If you do not or cannot agree to the terms of this License, please do not 
download or use the software.

1. General; Definitions. This License applies to any program or other work which Apple 
Computer, Inc. ("Apple") makes publicly available and which contains a notice placed 
by Apple identifying such program or work as "Original Code" and stating that it is 
subject to the terms of this Apple Public Source License version 2.0 ("License"). As used 
in this License: 1.1 "Applicable Patent Rights" mean: (a) in the case where Apple is the 
grantor of rights, (i) claims of patents that are now or hereafter acquired, owned by or 
assigned to Apple and (ii) that cover subject matter contained in the Original Code, but 
only to the extent necessary to use, reproduce and/or distribute the Original Code 
without infringement; and (b) in the case where You are the grantor of rights, (i) claims 
of patents that are now or hereafter acquired, owned by or assigned to You and (ii) that 
cover subject matter in Your Modifications, taken alone or in combination with Original 
Code.

1.2 "Contributor" means any person or entity that creates or contributes to the creation 
of Modifications.

1.3 "Covered Code" means the Original Code, Modifications, the combination of 
Original Code and any Modifications, and/or any respective portions thereof.

1.4 "Externally Deploy" means: (a) to sublicense, distribute or otherwise make Covered 
Code available, directly or indirectly, to anyone other than You; and/or (b) to use 
Covered Code, alone or as part of a Larger Work, in any way to provide a service, 
Wirecast User Guide | 142779



Acknowledgments
Acknowledgments

218
including but not limited to delivery of content, through electronic communication 
with a client other than You.

1.5 "Larger Work" means a work which combines Covered Code or portions thereof 
with code not governed by the terms of this License.

1.6 "Modifications" mean any addition to, deletion from, and/or change to, the 
substance and/or structure of the Original Code, any previous Modifications, the 
combination of Original Code and any previous Modifications, and/or any respective 
portions thereof. When code is released as a series of files, a Modification is: (a) any 
addition to or deletion from the contents of a file containing Covered Code; and/or (b) 
any new file or other representation of computer program statements that contains 
any part of Covered Code.

1.7 "Original Code" means (a) the Source Code of a program or other work as originally 
made available by Apple under this License, including the Source Code of any updates 
or upgrades to such programs or works made available by Apple under this License, 
and that has been expressly identified by Apple as such in the header file(s) of such 
work; and (b) the object code compiled from such Source Code and originally made 
available by Apple under this License.

1.8 "Source Code" means the human readable form of a program or other work that is 
suitable for making modifications to it, including all modules it contains, plus any 
associated interface definition files, scripts used to control compilation and installation 
of an executable (object code).

1.9 "You" or "Your" means an individual or a legal entity exercising rights under this 
License. For legal entities, "You" or "Your" includes any entity which controls, is 
controlled by, or is under common control with, You, where "control" means (a) the 
power, direct or indirect, to cause the direction or management of such entity, whether 
by contract or otherwise, or (b) ownership of fifty percent (50%) or more of the 
outstanding shares or beneficial ownership of such entity.

2. Permitted Uses; Conditions & Restrictions. Subject to the terms and conditions of this 
License, Apple hereby grants You, effective on the date You accept this License and 
download the Original Code, a world-wide, royalty-free, non-exclusive license, to the 
extent of Apple's Applicable Patent Rights and copyrights covering the Original Code, 
to do the following: 2.1 Unmodified Code. You may use, reproduce, display, perform, 
internally distribute within Your organization, and Externally Deploy verbatim, 
unmodified copies of the Original Code, for commercial or non-commercial purposes, 
provided that in each instance: (a) You must retain and reproduce in all copies of 
Original Code the copyright and other proprietary notices and disclaimers of Apple as 
they appear in the Original Code, and keep intact all notices in the Original Code that 
refer to this License; and (b) You must include a copy of this License with every copy of 
Source Code of Covered Code and documentation You distribute or Externally Deploy, 
and You may not offer or impose any terms on such Source Code that alter or restrict 
this License or the recipients' rights hereunder, except as permitted under Section 6.

2.2 Modified Code. You may modify Covered Code and use, reproduce, display, 
perform, internally distribute within Your organization, and Externally Deploy Your 
Modifications and Covered Code, for commercial or non-commercial purposes, 
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provided that in each instance You also meet all of these conditions: (a) You must satisfy 
all the conditions of Section 2.1 with respect to the Source Code of the Covered Code; 
(b) You must duplicate, to the extent it does not already exist, the notice in Exhibit A in 
each file of the Source Code of all Your Modifications, and cause the modified files to 
carry prominent notices stating that You changed the files and the date of any change; 
and (c) If You Externally Deploy Your Modifications, You must make Source Code of all 
Your Externally Deployed Modifications either available to those to whom You have 
Externally Deployed Your Modifications, or publicly available. Source Code of Your 
Externally Deployed Modifications must be released under the terms set forth in this 
License, including the license grants set forth in Section 3 below, for as long as you 
Externally Deploy the Covered Code or twelve (12) months from the date of initial 
External Deployment, whichever is longer. You should preferably distribute the Source 
Code of Your Externally Deployed Modifications electronically (e.g. download from a 
Web site).

2.3 Distribution of Executable Versions. In addition, if You Externally Deploy Covered 
Code (Original Code and/or Modifications) in object code, executable form only, You 
must include a prominent notice, in the code itself as well as in related documentation, 
stating that Source Code of the Covered Code is available under the terms of this 
License with information on how and where to obtain such Source Code.

2.4 Third Party Rights. You expressly acknowledge and agree that although Apple and 
each Contributor grants the licenses to their respective portions of the Covered Code 
set forth herein, no assurances are provided by Apple or any Contributor that the 
Covered Code does not infringe the patent or other intellectual property rights of any 
other entity. Apple and each Contributor disclaim any liability to You for claims brought 
by any other entity based on infringement of intellectual property rights or otherwise. 
As a condition to exercising the rights and licenses granted hereunder, You hereby 
assume sole responsibility to secure any other intellectual property rights needed, if 
any. For example, if a third party patent license is required to allow You to distribute the 
Covered Code, it is Your responsibility to acquire that license before distributing the 
Covered Code.

3. Your Grants. In consideration of, and as a condition to, the licenses granted to You 
under this License, You hereby grant to any person or entity receiving or distributing 
Covered Code under this License a non-exclusive, royalty-free, perpetual, irrevocable 
license, under Your Applicable Patent Rights and other intellectual property rights 
(other than patent) owned or controlled by You, to use, reproduce, display, perform, 
modify, sublicense, distribute and Externally Deploy Your Modifications of the same 
scope and extent as Apple's licenses under Sections 2.1 and 2.2 above.

4. Larger Works. You may create a Larger Work by combining Covered Code with other 
code not governed by the terms of this License and distribute the Larger Work as a 
single product. In each such instance, You must make sure the requirements of this 
License are fulfilled for the Covered Code or any portion thereof.

5. Limitations on Patent License. Except as expressly stated in Section 2, no other patent 
rights, express or implied, are granted by Apple herein. Modifications and/or Larger 
Works may require additional patent licenses from Apple which Apple may grant in its 
sole discretion.
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6. Additional Terms. You may choose to offer, and to charge a fee for, warranty, support, 
indemnity or liability obligations and/or other rights consistent with the scope of the 
license granted herein ("Additional Terms") to one or more recipients of Covered Code.

However, You may do so only on Your own behalf and as Your sole responsibility, and 
not on behalf of Apple or any Contributor. You must obtain the recipient's agreement 
that any such Additional Terms are offered by You alone, and You hereby agree to 
indemnify, defend and hold Apple and every Contributor harmless for any liability 
incurred by or claims asserted against Apple or such Contributor by reason of any such 
Additional Terms.

7. Versions of the License. Apple may publish revised and/or new versions of this 
License from time to time. Each version will be given a distinguishing version number. 
Once Original Code has been published under a particular version of this License, You 
may continue to use it under the terms of that version. You may also choose to use such 
Original Code under the terms of any subsequent version of this License published by 
Apple. No one other than Apple has the right to modify the terms applicable to 
Covered Code created under this License.

8. NO WARRANTY OR SUPPORT. The Covered Code may contain in whole or in part pre-
release, untested, or not fully tested works. The Covered Code may contain errors that 
could cause failures or loss of data, and may be incomplete or contain inaccuracies. You 
expressly acknowledge and agree that use of the Covered Code, or any portion thereof, 
is at Your sole and entire risk. THE COVERED CODE IS PROVIDED "AS IS" AND WITHOUT 
WARRANTY, UPGRADES OR SUPPORT OF ANY KIND AND APPLE AND APPLE'S 
LICENSOR(S) (COLLECTIVELY REFERRED TO AS "APPLE" FOR THE PURPOSES OF 
SECTIONS 8 AND 9) AND ALL CONTRIBUTORS EXPRESSLY DISCLAIM ALL WARRANTIES 
AND/OR CONDITIONS, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE 
IMPLIED WARRANTIES AND/OR CONDITIONS OF MERCHANTABILITY, OF SATISFACTORY 
QUALITY, OF FITNESS FOR A PARTICULAR PURPOSE, OF ACCURACY, OF QUIET 
ENJOYMENT, AND NONINFRINGEMENT OF THIRD PARTY RIGHTS. APPLE AND EACH 
CONTRIBUTOR DOES NOT WARRANT AGAINST INTERFERENCE WITH YOUR ENJOYMENT 
OF THE COVERED CODE, THAT THE FUNCTIONS CONTAINED IN THE COVERED CODE 
WILL MEET YOUR REQUIREMENTS, THAT THE OPERATION OF THE COVERED CODE WILL 
BE UNINTERRUPTED OR ERROR-FREE, OR THAT DEFECTS IN THE COVERED CODE WILL 
BE CORRECTED. NO ORAL OR WRITTEN INFORMATION OR ADVICE GIVEN BY APPLE, AN 
APPLE AUTHORIZED REPRESENTATIVE OR ANY CONTRIBUTOR SHALL CREATE A 
WARRANTY.

You acknowledge that the Covered Code is not intended for use in the operation of 
nuclear facilities, aircraft navigation, communication systems, or air traffic control 
machines in which case the failure of the Covered Code could lead to death, personal 
injury, or severe physical or environmental damage.

9. LIMITATION OF LIABILITY. TO THE EXTENT NOT PROHIBITED BY LAW, IN NO EVENT 
SHALL APPLE OR ANY CONTRIBUTOR BE LIABLE FOR ANY INCIDENTAL, SPECIAL, 
INDIRECT OR CONSEQUENTIAL DAMAGES ARISING OUT OF OR RELATING TO THIS 
LICENSE OR YOUR USE OR INABILITY TO USE THE COVERED CODE, OR ANY PORTION 
THEREOF, WHETHER UNDER A THEORY OF CONTRACT, WARRANTY, TORT (INCLUDING 
NEGLIGENCE), PRODUCTS LIABILITY OR OTHERWISE, EVEN IF APPLE OR SUCH 
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CONTRIBUTOR HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES AND 
NOTWITHSTANDING THE FAILURE OF ESSENTIAL PURPOSE OF ANY REMEDY. SOME 
JURISDICTIONS DO NOT ALLOW THE LIMITATION OF LIABILITY OF INCIDENTAL OR 
CONSEQUENTIAL DAMAGES, SO THIS LIMITATION MAY NOT APPLY TO YOU. In no event 
shall Apple's total liability to You for all damages (other than as may be required by 
applicable law) under this License exceed the amount of fifty dollars ($50.00).

10. Trademarks. This License does not grant any rights to use the trademarks or trade 
names "Apple", "Apple Computer", "Mac", "Mac OS", "QuickTime", "QuickTime streaming 
server" or any other trademarks, service marks, logos or trade names belonging to 
Apple (collectively "Apple Marks") or to any trademark, service mark, logo or trade 
name belonging to any Contributor. You agree not to use any Apple Marks in or as part 
of the name of products derived from the Original Code or to endorse or promote 
products derived from the Original Code other than as expressly permitted by and in 
strict compliance at all times with Apple's third party trademark usage guidelines 
which are posted at http://www.apple.com/legal/guidelinesfor3rdparties.html.

11. Ownership. Subject to the licenses granted under this License, each Contributor 
retains all rights, title and interest in and to any Modifications made by such 
Contributor. Apple retains all rights, title and interest in and to the Original Code and 
any Modifications made by or on behalf of Apple ("Apple Modifications"), and such 
Apple Modifications will not be automatically subject to this License. Apple may, at its 
sole discretion, choose to license such Apple Modifications under this License, or on 
different terms from those contained in this License or may choose not to license them 
at all.

12. Termination.

12.1 Termination. This License and the rights granted hereunder will terminate: (a) 
automatically without notice from Apple if You fail to comply with any term(s) of this 
License and fail to cure such breach within 30 days of becoming aware of such breach; 
(b) immediately in the event of the circumstances described in Section 13.5(b); or (c) 
automatically without notice from Apple if You, at any time during the term of this 
License, commence an action for patent infringement against Apple; provided that 
Apple did not first commence an action for patent infringement against You in that 
instance.

12.2 Effect of Termination. Upon termination, You agree to immediately stop any 
further use, reproduction, modification, sublicensing and distribution of the Covered 
Code. All sublicenses to the Covered Code which have been properly granted prior to 
termination shall survive any termination of this License. Provisions which, by their 
nature, should remain in effect beyond the termination of this License shall survive, 
including but not limited to Sections 3, 5, 8, 9, 10, 11, 12.2 and 13. No party will be liable 
to any other for compensation, indemnity or damages of any sort solely as a result of 
terminating this License in accordance with its terms, and termination of this License 
will be without prejudice to any other right or remedy of any party.

13. Miscellaneous.

13.1 Government End Users. The Covered Code is a "commercial item" as defined in FAR 
2.101. Government software and technical data rights in the Covered Code include only 
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those rights customarily provided to the public as defined in this License. This 
customary commercial license in technical data and software is provided in accordance 
with FAR 12.211 (Technical Data) and 12.212 (Computer Software) and, for Department 
of Defense purchases, DFAR 252.227-7015 (Technical Data -- Commercial Items) and 
227.7202-3 (Rights in Commercial Computer Software or Computer Software 
Documentation). Accordingly, all U.S. Government End Users acquire Covered Code 
with only those rights set forth herein.

13.2 Relationship of Parties. This License will not be construed as creating an agency, 
partnership, joint venture or any other form of legal association between or among 
You, Apple or any Contributor, and You will not represent to the contrary, whether 
expressly, by implication, appearance or otherwise.

13.3 Independent Development. Nothing in this License will impair Apple's right to 
acquire, license, develop, have others develop for it, market and/or distribute 
technology or products that perform the same or similar functions as, or otherwise 
compete with, Modifications, Larger Works, technology or products that You may 
develop, produce, market or distribute.

13.4 Waiver; Construction. Failure by Apple or any Contributor to enforce any provision 
of this License will not be deemed a waiver of future enforcement of that or any other 
provision. Any law or regulation which provides that the language of a contract shall be 
construed against the drafter will not apply to this License.

13.5 Severability. (a) If for any reason a court of competent jurisdiction finds any 
provision of this License, or portion thereof, to be unenforceable, that provision of the 
License will be enforced to the maximum extent permissible so as to effect the 
economic benefits and intent of the parties, and the remainder of this License will 
continue in full force and effect. (b) Notwithstanding the foregoing, if applicable law 
prohibits or restricts You from fully and/or specifically complying with Sections 2 and/
or 3 or prevents the enforceability of either of those Sections, this License will 
immediately terminate and You must immediately discontinue any use of the Covered 
Code and destroy all copies of it that are in your possession or control.

13.6 Dispute Resolution. Any litigation or other dispute resolution between You and 
Apple relating to this License shall take place in the Northern District of California, and 
You and Apple hereby consent to the personal jurisdiction of, and venue in, the state 
and federal courts within that District with respect to this License. The application of 
the United Nations Convention on Contracts for the International Sale of Goods is 
expressly excluded.

13.7 Entire Agreement; Governing Law. This License constitutes the entire agreement 
between the parties with respect to the subject matter hereof. This License shall be 
governed by the laws of the United States and the State of California, except that body 
of California law concerning conflicts of law.

Where You are located in the province of Quebec, Canada, the following clause applies: 
The parties hereby confirm that they have requested that this License and all related 
documents be drafted in English. Les parties ont exige que le present contrat et tous les 
documents connexes soient rediges en anglais.

EXHIBIT A.
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"Portions Copyright (c) 1999-2003 Apple Computer, Inc. All Rights Reserved.

This file contains Original Code and/or Modifications of Original Code as defined in and 
that are subject to the Apple Public Source License Version 2.0 (the 'License'). You may 
not use this file except in compliance with the License. Please obtain a copy of the 
License at http://www.opensource.apple.com/apsl/ and read it before using this. The 
Original Code and all software distributed under the License are distributed on an 'AS 
IS' basis, WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, AND APPLE 
HEREBY DISCLAIMS ALL SUCH WARRANTIES, INCLUDING WITHOUT LIMITATION, ANY 
WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, QUIET 
ENJOYMENT OR NON-INFRINGEMENT.

Please see the License for the specific language governing rights and limitations under 
the License." 

FFmpeg Project
GNU LESSER GENERAL PUBLIC LICENSE Version 2.1, February 1999 Copyright (C) 1991, 
1999 Free Software Foundation, Inc.

51 Franklin Street, Fifth Floor, Boston, MA 02110-1301 USA Everyone is permitted to 
copy and distribute verbatim copies of this license document, but changing it is not 
allowed.

[This is the first released version of the Lesser GPL. It also counts as the successor of the 
GNU Library Public License, version 2, hence the version number 2.1.] 

Preamble The licenses for most software are designed to take away your freedom to 
share and change it. By contrast, the GNU General Public Licenses are intended to 
guarantee your freedom to share and change free software--to make sure the software 
is free for all its users.

This license, the Lesser General Public License, applies to some specially designated 
software packages--typically libraries--of the Free Software Foundation and other 
authors who decide to use it. You can use it too, but we suggest you first think carefully 
about whether this license or the ordinary General Public License is the better strategy 
to use in any particular case, based on the explanations below.

When we speak of free software, we are referring to freedom of use, not price. Our 
General Public Licenses are designed to make sure that you have the freedom to 
distribute copies of free software (and charge for this service if you want); that you 
receive source code or can get it if you want it; that you can change the software and 
use pieces of it in new free programs; and that you are informed that you can do these 
things.

To protect your rights, we need to make restrictions that forbid distributors to deny you 
these rights or to ask you to surrender these rights. These restrictions translate to 
certain responsibilities for you if you distribute copies of the library or if you modify it.

For example, if you distribute copies of the library, whether gratis or for a fee, you must 
give the recipients all the rights that we gave you. You must make sure that they, too, 
receive or can get the source code. If you link other code with the library, you must 
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provide complete object files to the recipients, so that they can relink them with the 
library after making changes to the library and recompiling it. And you must show 
them these terms so they know their rights.

We protect your rights with a two-step method: (1) we copyright the library, and (2) we 
offer you this license, which gives you legal permission to copy, distribute and/or 
modify the library.

To protect each distributor, we want to make it very clear that there is no warranty for 
the free library. Also, if the library is modified by someone else and passed on, the 
recipients should know that what they have is not the original version, so that the 
original author's reputation will not be affected by problems that might be introduced 
by others.

Finally, software patents pose a constant threat to the existence of any free program. 
We want to make sure that a company cannot effectively restrict the users of a free 
program by obtaining a restrictive license from a patent holder. Therefore, we insist 
that any patent license obtained for a version of the library must be consistent with the 
full freedom of use specified in this license.

Most GNU software, including some libraries, is covered by the ordinary GNU General 
Public License. This license, the GNU Lesser General Public License, applies to certain 
designated libraries, and is quite different from the ordinary General Public License. We 
use this license for certain libraries in order to permit linking those libraries into non-
free programs.

When a program is linked with a library, whether statically or using a shared library, the 
combination of the two is legally speaking a combined work, a derivative of the original 
library. The ordinary General Public License therefore permits such linking only if the 
entire combination fits its criteria of freedom. The Lesser General Public License permits 
more lax criteria for linking other code with the library.

We call this license the "Lesser" General Public License because it does Less to protect 
the user's freedom than the ordinary General Public License. It also provides other free 
software developers Less of an advantage over competing non-free programs. These 
disadvantages are the reason we use the ordinary General Public License for many 
libraries. However, the Lesser license provides advantages in certain special 
circumstances.

For example, on rare occasions, there may be a special need to encourage the widest 
possible use of a certain library, so that it becomes a de-facto standard. To achieve this, 
non-free programs must be allowed to use the library. A more frequent case is that a 
free library does the same job as widely used non-free libraries. In this case, there is 
little to gain by limiting the free library to free software only, so we use the Lesser 
General Public License.

In other cases, permission to use a particular library in non-free programs enables a 
greater number of people to use a large body of free software. For example, permission 
to use the GNU C Library in non-free programs enables many more people to use the 
whole GNU operating system, as well as its variant, the GNU/Linux operating system.
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Although the Lesser General Public License is Less protective of the users' freedom, it 
does ensure that the user of a program that is linked with the Library has the freedom 
and the wherewithal to run that program using a modified version of the Library.

The precise terms and conditions for copying, distribution and modification follow. Pay 
close attention to the difference between a "work based on the library" and a "work 
that uses the library". The former contains code derived from the library, whereas the 
latter must be combined with the library in order to run.

GNU LESSER GENERAL PUBLIC LICENSE TERMS AND CONDITIONS FOR COPYING, 
DISTRIBUTION AND MODIFICATION This License Agreement applies to any software 
library or other program which contains a notice placed by the copyright holder or 
other authorized party saying it may be distributed under the terms of this Lesser 
General Public License (also called "this License").

Each licensee is addressed as "you".

A "library" means a collection of software functions and/or data prepared so as to be 
conveniently linked with application programs (which use some of those functions and 
data) to form executables.

The "Library", below, refers to any such software library or work which has been 
distributed under these terms. A "work based on the Library" means either the Library 
or any derivative work under copyright law: that is to say, a work containing the Library 
or a portion of it, either verbatim or with modifications and/or translated 
straightforwardly into another language. (Hereinafter, translation is included without 
limitation in the term "modification".) "Source code" for a work means the preferred 
form of the work for making modifications to it. For a library, complete source code 
means all the source code for all modules it contains, plus any associated interface 
definition files, plus the scripts used to control compilation and installation of the 
library.

Activities other than copying, distribution and modification are not covered by this 
License; they are outside its scope. The act of running a program using the Library is not 
restricted, and output from such a program is covered only if its contents constitute a 
work based on the Library (independent of the use of the Library in a tool for writing it). 
Whether that is true depends on what the Library does and what the program that uses 
the Library does.

1. You may copy and distribute verbatim copies of the Library's complete source code 
as you receive it, in any medium, provided that you conspicuously and appropriately 
publish on each copy an appropriate copyright notice and disclaimer of warranty; keep 
intact all the notices that refer to this License and to the absence of any warranty; and 
distribute a copy of this License along with the Library.

You may charge a fee for the physical act of transferring a copy, and you may at your 
option offer warranty protection in exchange for a fee.

2. You may modify your copy or copies of the Library or any portion of it, thus forming a 
work based on the Library, and copy and distribute such modifications or work under 
the terms of Section 1 above, provided that you also meet all of these conditions: a) The 
modified work must itself be a software library.
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b) You must cause the files modified to carry prominent notices stating that you 
changed the files and the date of any change.

c) You must cause the whole of the work to be licensed at no charge to all third parties 
under the terms of this License.

d) If a facility in the modified Library refers to a function or a table of data to be supplied 
by an application program that uses the facility, other than as an argument passed 
when the facility is invoked, then you must make a good faith effort to ensure that, in 
the event an application does not supply such function or table, the facility still 
operates, and performs whatever part of its purpose remains meaningful.

(For example, a function in a library to compute square roots has a purpose that is 
entirely well-defined independent of the application. Therefore, Subsection 2d requires 
that any application-supplied function or table used by this function must be optional: 
if the application does not supply it, the square root function must still compute square 
roots.) These requirements apply to the modified work as a whole. If identifiable 
sections of that work are not derived from the Library, and can be reasonably 
considered independent and separate works in themselves, then this License, and its 
terms, do not apply to those sections when you distribute them as separate works. But 
when you distribute the same sections as part of a whole which is a work based on the 
Library, the distribution of the whole must be on the terms of this License, whose 
permissions for other licensees extend to the entire whole, and thus to each and every 
part regardless of who wrote it.

Thus, it is not the intent of this section to claim rights or contest your rights to work 
written entirely by you; rather, the intent is to exercise the right to control the 
distribution of derivative or collective works based on the Library.

In addition, mere aggregation of another work not based on the Library with the 
Library (or with a work based on the Library) on a volume of a storage or distribution 
medium does not bring the other work under the scope of this License.

3. You may opt to apply the terms of the ordinary GNU General Public License instead 
of this License to a given copy of the Library. To do this, you must alter all the notices 
that refer to this License, so that they refer to the ordinary GNU General Public License, 
version 2, instead of to this License. (If a newer version than version 2 of the ordinary 
GNU General Public License has appeared, then you can specify that version instead if 
you want.) Do not make any other change in these notices.

Once this change is made in a given copy, it is irreversible for that copy, so the ordinary 
GNU General Public License applies to all subsequent copies and derivative works 
made from that copy.

This option is useful when you want to copy part of the code of the Library into a 
program that is not a library.

4. You may copy and distribute the Library (or a portion or derivative of it, under 
Section 2) in object code or executable form under the terms of Sections 1 and 2 above 
provided that you accompany it with the complete corresponding machine-readable 
source code, which must be distributed under the terms of Sections 1 and 2 above on a 
medium customarily used for software interchange.
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If distribution of object code is made by offering access to copy from a designated 
place, then offering equivalent access to copy the source code from the same place 
satisfies the requirement to distribute the source code, even though third parties are 
not compelled to copy the source along with the object code.

5. A program that contains no derivative of any portion of the Library, but is designed 
to work with the Library by being compiled or linked with it, is called a "work that uses 
the Library". Such a work, in isolation, is not a derivative work of the Library, and 
therefore falls outside the scope of this License.

However, linking a "work that uses the Library" with the Library creates an executable 
that is a derivative of the Library (because it contains portions of the Library), rather 
than a "work that uses the library". The executable is therefore covered by this License.

Section 6 states terms for distribution of such executables.

When a "work that uses the Library" uses material from a header file that is part of the 
Library, the object code for the work may be a derivative work of the Library even 
though the source code is not.

Whether this is true is especially significant if the work can be linked without the 
Library, or if the work is itself a library. The threshold for this to be true is not precisely 
defined by law.

If such an object file uses only numerical parameters, data structure layouts and 
accessors, and small macros and small inline functions (ten lines or less in length), then 
the use of the object file is unrestricted, regardless of whether it is legally a derivative 
work. (Executables containing this object code plus portions of the Library will still fall 
under Section 6.) Otherwise, if the work is a derivative of the Library, you may distribute 
the object code for the work under the terms of Section 6.

Any executables containing that work also fall under Section 6, whether or not they are 
linked directly with the Library itself.

6. As an exception to the Sections above, you may also combine or link a "work that 
uses the Library" with the Library to produce a work containing portions of the Library, 
and distribute that work under terms of your choice, provided that the terms permit 
modification of the work for the customer's own use and reverse engineering for 
debugging such modifications.

You must give prominent notice with each copy of the work that the Library is used in it 
and that the Library and its use are covered by this License. You must supply a copy of 
this License. If the work during execution displays copyright notices, you must include 
the copyright notice for the Library among them, as well as a reference directing the 
user to the copy of this License. Also, you must do one of these things: a) Accompany 
the work with the complete corresponding machine-readable source code for the 
Library including whatever changes were used in the work (which must be distributed 
under Sections 1 and 2 above); and, if the work is an executable linked with the Library, 
with the complete machine-readable "work that uses the Library", as object code and/
or source code, so that the user can modify the Library and then relink to produce a 
modified executable containing the modified Library. (It is understood that the user 
who changes the contents of definitions files in the Library will not necessarily be able 
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to recompile the application to use the modified definitions.) b) Use a suitable shared 
library mechanism for linking with the Library. A suitable mechanism is one that (1) 
uses at run time a copy of the library already present on the user's computer system, 
rather than copying library functions into the executable, and (2) will operate properly 
with a modified version of the library, if the user installs one, as long as the modified 
version is interface-compatible with the version that the work was made with.

c) Accompany the work with a written offer, valid for at least three years, to give the 
same user the materials specified in Subsection 6a, above, for a charge no more than 
the cost of performing this distribution. 

d) If distribution of the work is made by offering access to copy from a designated 
place, offer equivalent access to copy the above specified materials from the same 
place.

e) Verify that the user has already received a copy of these materials or that you have 
already sent this user a copy.

For an executable, the required form of the "work that uses the Library" must include 
any data and utility programs needed for reproducing the executable from it. However, 
as a special exception, the materials to be distributed need not include anything that is 
normally distributed (in either source or binary form) with the major components 
(compiler, kernel, and so on) of the operating system on which the executable runs, 
unless that component itself accompanies the executable.

It may happen that this requirement contradicts the license restrictions of other 
proprietary libraries that do not normally accompany the operating system. Such a 
contradiction means you cannot use both them and the Library together in an 
executable that you distribute.

7. You may place library facilities that are a work based on the Library side-by-side in a 
single library together with other library facilities not covered by this License, and 
distribute such a combined library, provided that the separate distribution of the work 
based on the Library and of the other library facilities is otherwise permitted, and 
provided that you do these two things: a) Accompany the combined library with a copy 
of the same work based on the Library, uncombined with any other library facilities. 
This must be distributed under the terms of the Sections above.

b) Give prominent notice with the combined library of the fact that part of it is a work 
based on the Library, and explaining where to find the accompanying uncombined 
form of the same work.

8. You may not copy, modify, sublicense, link with, or distribute the Library except as 
expressly provided under this License. Any attempt otherwise to copy, modify, 
sublicense, link with, or distribute the Library is void, and will automatically terminate 
your rights under this License. However, parties who have received copies, or rights, 
from you under this License will not have their licenses terminated so long as such 
parties remain in full compliance.

9. You are not required to accept this License, since you have not signed it. However, 
nothing else grants you permission to modify or distribute the Library or its derivative 
works. These actions are prohibited by law if you do not accept this License. Therefore, 
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by modifying or distributing the Library (or any work based on the Library), you 
indicate your acceptance of this License to do so, and all its terms and conditions for 
copying, distributing or modifying the Library or works based on it.

10. Each time you redistribute the Library (or any work based on the Library), the 
recipient automatically receives a license from the original licensor to copy, distribute, 
link with or modify the Library subject to these terms and conditions. You may not 
impose any further restrictions on the recipients' exercise of the rights granted herein.

You are not responsible for enforcing compliance by third parties with this License.

11. If, as a consequence of a court judgment or allegation of patent infringement or for 
any other reason (not limited to patent issues), conditions are imposed on you 
(whether by court order, agreement or otherwise) that contradict the conditions of this 
License, they do not excuse you from the conditions of this License. If you cannot 
distribute so as to satisfy simultaneously your obligations under this License and any 
other pertinent obligations, then as a consequence you may not distribute the Library 
at all. For example, if a patent license would not permit royalty-free redistribution of the 
Library by all those who receive copies directly or indirectly through you, then the only 
way you could satisfy both it and this License would be to refrain entirely from 
distribution of the Library.

If any portion of this section is held invalid or unenforceable under any particular 
circumstance, the balance of the section is intended to apply, and the section as a 
whole is intended to apply in other circumstances.

It is not the purpose of this section to induce you to infringe any patents or other 
property right claims or to contest validity of any such claims; this section has the sole 
purpose of protecting the integrity of the free software distribution system which is 
implemented by public license practices. Many people have made generous 
contributions to the wide range of software distributed through that system in reliance 
on consistent application of that system; it is up to the author/donor to decide if he or 
she is willing to distribute software through any other system and a licensee cannot 
impose that choice.

This section is intended to make thoroughly clear what is believed to be a consequence 
of the rest of this License.

12. If the distribution and/or use of the Library is restricted in certain countries either by 
patents or by copyrighted interfaces, the original copyright holder who places the 
Library under this License may add an explicit geographical distribution limitation 
excluding those countries, so that distribution is permitted only in or among countries 
not thus excluded. In such case, this License incorporates the limitation as if written in 
the body of this License.

13. The Free Software Foundation may publish revised and/or new versions of the 
Lesser General Public License from time to time.

Such new versions will be similar in spirit to the present version, but may differ in detail 
to address new problems or concerns.
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Each version is given a distinguishing version number. If the Library specifies a version 
number of this License which applies to it and "any later version", you have the option 
of following the terms and conditions either of that version or of any later version 
published by the Free Software Foundation. If the Library does not specify a license 
version number, you may choose any version ever published by the Free Software 
Foundation.

14. If you want to incorporate parts of the Library into other free programs whose 
distribution conditions are incompatible with these, write to the author to ask for 
permission. For software which is copyrighted by the Free Software Foundation, write 
to the Free Software Foundation; we sometimes make exceptions for this. Our decision 
will be guided by the two goals of preserving the free status of all derivatives of our free 
software and of promoting the sharing and reuse of software generally.

NO WARRANTY 15. BECAUSE THE LIBRARY IS LICENSED FREE OF CHARGE, THERE IS NO 
WARRANTY FOR THE LIBRARY, TO THE EXTENT PERMITTED BY APPLICABLE LAW.

EXCEPT WHEN OTHERWISE STATED IN WRITING THE COPYRIGHT HOLDERS AND/OR 
OTHER PARTIES PROVIDE THE LIBRARY "AS IS" WITHOUT WARRANTY OF ANY KIND, 
EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE 
ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE LIBRARY IS WITH YOU. 
SHOULD THE LIBRARY PROVE DEFECTIVE, YOU ASSUME THE COST OF ALL NECESSARY 
SERVICING, REPAIR OR CORRECTION.

16. IN NO EVENT UNLESS REQUIRED BY APPLICABLE LAW OR AGREED TO IN WRITING 
WILL ANY COPYRIGHT HOLDER, OR ANY OTHER PARTY WHO MAY MODIFY AND/OR 
REDISTRIBUTE THE LIBRARY AS PERMITTED ABOVE, BE LIABLE TO YOU FOR DAMAGES, 
INCLUDING ANY GENERAL, SPECIAL, INCIDENTAL OR CONSEQUENTIAL DAMAGES 
ARISING OUT OF THE USE OR INABILITY TO USE THE LIBRARY (INCLUDING BUT NOT 
LIMITED TO LOSS OF DATA OR DATA BEING RENDERED INACCURATE OR LOSSES 
SUSTAINED BY YOU OR THIRD PARTIES OR A FAILURE OF THE LIBRARY TO OPERATE 
WITH ANY OTHER SOFTWARE), EVEN IF SUCH HOLDER OR OTHER PARTY HAS BEEN 
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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